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1 Vorwort
Das Sicherheitsmodul SY6 erweitert STÖBER Antriebsregler der Baureihe SC6 oder SI6 um die Sicherheitsfunktionen Safe
Torque Off (STO) und Safe Stop 1 (SS1), beide normativ in DIN EN 61800-5-2 beschrieben.

STO verhindert in einem Antriebsregler unmittelbar, nachdem die Sicherheitsfunktion aktiviert wurde, die Erzeugung eines
elektrischen Drehfelds, das für den Betrieb von Synchron- oder Asynchronmotoren benötigt wird. Im Fall von SS1-t erfolgt
die Abschaltung nach einer konfigurierbaren Zeit.

Bei der Kombination aus Antriebsregler und Sicherheitsmodul SY6 werden die Sicherheitsfunktionen STO und SS1 über
EtherCAT (FSoE) angesteuert.

SY6 arbeitet als vollelektronische Lösung schnell und verschleißfrei. Das Sicherheitsmodul ist derart konzipiert, dass
regelmäßige, betriebsunterbrechende Systemtests entfallen. Für die Praxis bedeutet dies eine gesteigerte Verfügbarkeit
von Maschinen und Anlagen. Darüber hinaus entfällt die oft sehr aufwändige Planung und Dokumentation von
Funktionstests.

Antriebsregler mit integriertem Sicherheitsmodul sind in sicherheitstechnisch anspruchsvollen Systemen bis SIL 3, PL e,
Kategorie 4 einsetzbar. Die Übereinstimmung mit den normativen Anforderungen wurde durch ein unabhängiges
Prüfinstitut im Rahmen einer Baumusterprüfung zertifiziert.

Die Antriebsregler der Baureihen SC6 und SI6 absolvierten erfolgreich den EtherCAT sowie den Fail Safe over EtherCAT
(FSoE) Conformance Test. Hierbei wurde die Kommunikationsschnittstelle getestet, um die Zuverlässigkeit und
herstellerunabhängige Funktionalität der unterlagerten Kommunikation zu gewährleisten.
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2 Benutzerinformationen
Diese Dokumentation bietet sämtliche Informationen zum bestimmungsgemäßen Einsatz des Antriebsreglers in
Kombination mit dem Sicherheitsmodul SY6.

2.1 Aufbewahrung und Weitergabe
Da diese Dokumentation wichtige Informationen zum sicheren und effizienten Umgang mit dem Produkt enthält, bewahren
Sie diese bis zur Produktentsorgung unbedingt in unmittelbarer Nähe des Produkts und für das qualifizierte Personal
jederzeit zugänglich auf.

Bei Übergabe oder Verkauf des Produkts an Dritte geben Sie diese Dokumentation ebenfalls weiter.

2.2 Beschriebenes Produkt
Diese Dokumentation ist verbindlich für:

Antriebsregler der Baureihe SC6 oder SI6 in Verbindung mit dem Sicherheitsmodul SY6 und der Software DriveControlSuite
(DS6) ab V 6.4-E und zugehöriger Firmware ab V 6.4-E.

2.3 Aktualität
Prüfen Sie, ob Ihnen mit diesem Dokument die aktuelle Version der Dokumentation vorliegt. Auf unserer Webseite stellen
wir Ihnen die neuesten Dokumentversionen zu unseren Produkten zum Download zur Verfügung:
http://www.stoeber.de/de/downloads/.

2.4 Originalsprache
Die Originalsprache dieser Dokumentation ist Deutsch; alle anderssprachigen Fassungen sind von der Originalsprache
abgeleitet.

2.5 Haftungsbeschränkung
Diese Dokumentation wurde unter Berücksichtigung der geltenden Normen und Vorschriften sowie des Stands der Technik
erstellt.

Für Schäden, die aufgrund einer Nichtbeachtung der Dokumentation oder aufgrund der nicht bestimmungsgemäßen
Verwendung des Produkts entstehen, übernimmt STÖBER keine Haftung. Dies gilt insbesondere für Schäden, die durch
individuelle technische Veränderungen des Produkts oder dessen Projektierung und Bedienung durch nicht qualifiziertes
Personal hervorgerufen wurden.

http://www.stoeber.de/de/downloads/
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2.6 Darstellungskonventionen
Damit Sie besondere Informationen in dieser Dokumentation schnell zuordnen können, sind diese durch
Orientierungshilfen in Form von Signalwörtern, Symbolen und speziellen Textauszeichnungen hervorgehoben.

2.6.1 Gebrauch von Symbolen
Sicherheitshinweise sind durch nachfolgende Symbole gekennzeichnet. Sie weisen Sie auf besondere Gefahren im Umgang
mit dem Produkt hin und werden durch entsprechende Signalworte begleitet, die das Ausmaß der Gefährdung zum
Ausdruck bringen. Darüber hinaus sind nützliche Tipps und Empfehlungen für einen effizienten und einwandfreien Betrieb
besonders hervorgehoben.

ACHTUNG!

Achtung

bedeutet, dass ein Sachschaden eintreten kann,

▪ wenn die genannten Vorsichtsmaßnahmen nicht getroffen werden.

VORSICHT!

Vorsicht

mit Warndreieck bedeutet, dass eine leichte Körperverletzung eintreten kann,

▪ wenn die genannten Vorsichtsmaßnahmen nicht getroffen werden.

WARNUNG!

Warnung

mit Warndreieck bedeutet, dass erhebliche Lebensgefahr eintreten kann,

▪ wenn die genannten Vorsichtsmaßnahmen nicht getroffen werden.

GEFAHR!

Gefahr

mit Warndreieck bedeutet, dass erhebliche Lebensgefahr eintreten wird,

▪ wenn die genannten Vorsichtsmaßnahmen nicht getroffen werden.

Information

Information bedeutet eine wichtige Information über das Produkt oder die Hervorhebung eines Dokumentationsteils, auf
den besonders aufmerksam gemacht werden soll.
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2.6.2 Auszeichnung von Textelementen
Bestimmte Elemente des Fließtexts werden wie folgt ausgezeichnet.

Wichtige Information Wörter oder Ausdrücke mit besonderer Bedeutung

Interpolated position mode Optional: Datei-, Produkt- oder sonstige Namen

Weiterführende Informationen Interner Querverweis

http://www.musterlink.de Externer Querverweis

Software- und Display-Anzeigen

Um den unterschiedlichen Informationsgehalt von Elementen, die von der Software-Oberfläche oder dem Display eines
Antriebsreglers zitiert werden sowie eventuelle Benutzereingaben entsprechend kenntlich zu machen, werden folgende
Darstellungen verwendet.

Hauptmenü 
Einstellungen

Von der Oberfläche zitierte Fenster-, Dialog- , Seitennamen oder
Schaltflächen, zusammengesetzte Eigennamen, Funktionen

Wählen Sie 
Referenziermethode A

Vorgegebene Eingabe

Hinterlegen Sie Ihre 
<Eigene IP-Adresse>

Benutzerdefinierte Eingabe

EREIGNIS 52: 
KOMMUNIKATION

Display-Anzeigen (Status, Meldungen, Warnungen, Störungen), von der
Oberfläche zitierte Statusinformationen

Tastenkürzel und Befehlsfolgen oder Pfade sind folgendermaßen dargestellt.

[STRG], [STRG] + [S] Taste, Tastaturkürzel

Tabelle > Tabelle einfügen Navigation zu Menüs/Untermenüs (Pfadangabe)

Parameterkennung-Lesart

Eine Parameterkennung setzt sich aus nachfolgenden Elementen zusammen, wobei auch Kurzformen, d. h. die
ausschließliche Angabe einer Koordinate oder die Kombination aus Koordinate und Name möglich sind.

E50 V0

Koordinate Name Version

Antriebsregler

2.6.3 Mathematik und Formeln
Zur Darstellung von mathematischen Zusammenhängen und Formeln werden die folgenden Zeichen verwendet.

- Subtraktion

+ Addition

× Multiplikation

÷ Division

| | Betrag

http://www.stoeber.de
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2.7 Marken
Die folgenden Namen, die in Verbindung mit dem Gerät, seiner optionalen Ausstattung und seinem Zubehör verwendet
werden, sind Marken oder eingetragene Marken anderer Unternehmen:

EtherCAT®,
Safety over EtherCAT®,
TwinCAT®

EtherCAT®, Safety over EtherCAT® und TwinCAT® sind eingetragene Marken und
patentierte Technologien, lizensiert durch die Beckhoff Automation GmbH, Verl,
Deutschland.

Alle anderen, hier nicht aufgeführten Marken, sind Eigentum ihrer jeweiligen Inhaber.

Erzeugnisse, die als Marken eingetragen sind, sind in dieser Dokumentation nicht besonders kenntlich gemacht.
Vorliegende Schutzrechte (Patente, Warenzeichen, Gebrauchsmusterschutz) sind zu beachten.
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3 Allgemeine Sicherheitshinweise
Von dem in dieser Dokumentation beschriebenen Produkt können Gefahren ausgehen, die durch die Einhaltung der
beschriebenen Warn- und Sicherheitshinweise sowie der enthaltenen technischen Regeln und Vorschriften vermieden
werden können.

3.1 Normen
Folgende Normen sind für das in dieser Dokumentation spezifizierte Produkt relevant:

§ DIN EN ISO 13849-1:2016

§ DIN EN ISO 13849-2:2013

§ DIN EN 61800-5-2:2017-11

§ DIN EN 61508-x:2011

§ DIN EN 60204-1:2007

§ DIN EN 62061:2016

§ IEC 61784-3:2010

Aus Gründen der besseren Lesbarkeit wird bei nachfolgenden Normverweisen auf die Angabe der jeweiligen Jahreszahl
verzichtet.

3.2 Qualifiziertes Personal
Um die in dieser Dokumentation beschriebenen Aufgaben ausführen zu können, müssen die damit betrauten Personen
fachlich entsprechend qualifiziert sein sowie die Risiken und Restgefahren beim Umgang mit den Produkten einschätzen
können. Sämtliche Arbeiten an den Produkten sowie deren Bedienung und Entsorgung dürfen aus diesem Grund
ausschließlich von fachlich qualifiziertem Personal ausgeführt werden.

Bei qualifiziertem Personal handelt es sich um Personen, die die Berechtigung zur Ausführung der genannten Tätigkeiten,
entweder durch eine Ausbildung zur Fachkraft oder die Unterweisung durch Fachkräfte, erworben haben.

Darüber hinaus müssen gültige Vorschriften, gesetzliche Vorgaben, geltende Regelwerke, diese Dokumentation sowie die in
dieser enthaltenen Sicherheitshinweise sorgfältig gelesen, verstanden und beachtet werden.

3.3 Bestimmungsgemäße Verwendung
Das Sicherheitsmodul SY6 ist mit STÖBER Antriebsreglern der Baureihe SC6 oder SI6 kombinierbar.

Wird ein Antriebsregler mit dem integrierten Sicherheitsmodul SY6 in einer sicherheitsrelevanten Anwendung eingesetzt,
muss das Sicherheitsmodul unbedingt von einem Sicherheitsschaltgerät oder einer Sicherheitssteuerung angesteuert
werden.

GEFAHR!

Elektrische Spannung! Lebensgefahr durch Stromschlag!

Eine aktivierte Sicherheitsfunktion STO bedeutet lediglich eine unterbrochene Drehfelderzeugung am Motor. An diesem
können immer noch hohe, gefährliche Spannungen anliegen.

▪ Stellen Sie sicher, dass spannungsführende Teile nicht berührt werden können.

▪ Muss die Versorgungsspannung abgeschaltet werden, beachten Sie die Anforderungen der DIN EN 60204-1.
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Nicht bestimmungsgemäße Verwendung

Das Sicherheitsmodul darf nicht außerhalb des Antriebsreglers oder der geltenden technischen Spezifikationen betrieben
werden.

Information

Mit dem Sicherheitsmodul SY6 ist kein Not-Aus gemäß DIN EN 60204-1 möglich! 
Beachten Sie diese Norm bei der Unterscheidung von Not-Aus und Not-Halt in Verbindung mit Safe Torque Off.

Modifikation

Als Anwender dürfen Sie das Sicherheitsmodul SY6 weder baulichen noch technischen oder elektrischen Veränderungen
unterziehen. Es ist nicht erlaubt, das Modul aus dem Antriebsregler zu entnehmen, zu reparieren oder auszutauschen.

Wartung

Das Sicherheitsmodul ist wartungsfrei.

Produktlebensdauer

Ein Antriebsregler mit integriertem Sicherheitsmodul muss 20 Jahre nach dem Produktionsdatum außer Betrieb genommen
werden. Das Produktionsdatum eines Antriebsregler entnehmen Sie dem zugehörigen Typenschild.

3.4 Außerbetriebsetzung
Beachten Sie bei sicherheitsgerichteten Anwendungen die Gebrauchsdauer TM = 20 Jahre in den sicherheitstechnischen
Kennzahlen.
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4 Sicherheitsmodul SY6
Das Sicherheitsmodul SY6 erweitert den Antriebsregler um die Sicherheitsfunktionen STO (Safe Torque Off) und SS1 (Safe
Stop 1). Das Modul verhindert die Entstehung eines Drehfelds im Leistungsteil des Antriebsreglers und schaltet – im
Fehlerfall oder auf externe Anforderung hin – den Antriebsregler unmittelbar oder zeitverzögert (SS1-t) in den Zustand STO.

Merkmale

§ Realisierbare Sicherheitsfunktionen:

• Sicher abgeschaltetes Moment – STO gemäß DIN EN 61800-5-2

• Stoppkategorie 0 gemäß DIN EN 60204-1

• Sicherer Stopp 1 (zeitverzögert) – SS1-t gemäß DIN EN 61800-5-2

• Stoppkategorie 1 gemäß DIN EN 60204-1

§ Ansteuerung der Sicherheitsfunktionen über Safety over EtherCAT (FSoE)

§ STO-Abschaltzeit: < 50 ms

§ Verschleißfrei

Zertifizierungen nach DIN EN 61800-5-2 und DIN EN ISO 13849-1

§ Safety Integrity Level  (SIL) 3

§ Performance Level  (PL) e

§ Kategorie 4
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5 Systemaufbau und Funktionsweise
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Abb. 1: Komponenten des FSoE-basierten Sicherheitskonzepts

Systemkomponenten

Zentrale Komponenten dieses auf FSoE-basierenden Sicherheitskonzepts sind:

§ Antriebsregler mit integriertem Sicherheitsmodul SY6
... für die Realisierung der Sicherheitsfunktionen STO und SS1-t

§ Steuerung (SPS) mit integriertem EtherCAT-Master
-... für die Organisation der gesamten Netzwerkkommunikation

§ Buskoppler (EtherCAT-Koppler)
... als Bindeglied zwischen Steuerung und Sicherheitssteuerung; der Buskoppler reicht die Telegramme der
Sicherheitssteuerung an den EtherCAT-Master weiter

§ Sicherheitssteuerung (S-SPS) mit integriertem FSoE-Master
... für die FSoE-Kommunikation sowie die logische Verknüpfung der FSoE-Teilnehmer; die Sicherheitssteuerung
beinhaltet zertifizierte Sicherheitsfunktionsbausteine, die mithilfe einer geeigneten Automatisierungs-Software
anwendungsspezifisch konfiguriert werden können

§ Safety-Terminals mit digitalen fehlersicheren Ein- und Ausgängen
... für den Anschluss von 24 VDC-Sicherheitssensoren wie beispielsweise Not-Halt- oder Positionsschalter,
Lichtschranken, Trittmatten etc.

§ FSoE-Protokoll
... für die Übertragung sicherheitsrelevanter Daten

§ EtherCAT
... als zugrundeliegendes Feldbussystem
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Funktionsweise

Das Steuerteil des Antriebsreglers generiert Pulsmuster (PWM) zur Erzeugung eines Drehfelds am IGBT-Modul des
Leistungsteils. Dieses Drehfeld ist zum Betrieb von Synchron- und Asynchronmotoren notwendig.

Ist die Sicherheitsfunktion nicht aktiv, gibt das Sicherheitsmodul SY6 die Drehfeldgenerierung im Leistungsteil frei; der
angeschlossene Motor kann ein Drehfeld aufbauen. Ist die Sicherheitsfunktion aktiv, sperrt SY6 die Drehfeldgenerierung im
Leistungsteil, und der Antriebsregler kann im angeschlossenen Motor kein Drehmoment erzeugen.

Das Sicherheitsmodul SY6 implementiert einen FSoE-Slave. Dieser tauscht Steuer- und Statusinformationen mit dem FSoE-
Master via EtherCAT-Master gemäß dem Black-Channel-Prinzip aus. Der Slave entpackt die sicherheitsrelevanten Daten,
plausibilisiert diese und gibt die beiden Sicherheitskanäle im Leistungsteil frei oder sperrt diese.

Die Sicherheitsfunktionen STO und SS1-t sind gerätebezogen, nicht achsspezifisch. Bei Doppelachsreglern werden beide
Achsen zugleich in den sicheren Zustand gesetzt. 
Ein aktivierter SS1 kann nicht abgebrochen werden.

WARNUNG!

Erhöhter Nachlaufweg! Restbewegung!

Das Sicherheitsmodul kann ein Versagen des funktionalen Teils des Antriebsreglers (z. B. beim gesteuerten Stillsetzen),
während die Sicherheitsfunktion SS1-t ausgeführt wird, nicht verhindern. Deshalb kann SS1-t nicht angewendet werden,
wenn dieses Versagen eine gefahrbringende Situation in der Endanwendung verursachen kann. Beachten Sie dies bei der
Projektierung.

Bei einem Fehler im Leistungsteil des Antriebsreglers ist – trotz aktivem STO – eine statische Bestromung des Motors
möglich, wobei sich die Motorwelle maximal um den Winkel 360° ÷ (p × 2) bewegen kann.
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6 Technische Daten
Die Transport-, Lager- und Betriebsbedingungen des Sicherheitsmoduls entnehmen Sie den technischen Daten des
Antriebsreglers (siehe Kapitel Weiterführende Informationen [} 49]).

Nachfolgende Tabelle beinhaltet die für die Sicherheitstechnik relevanten Kenngrößen des Moduls SY6.

SIL CL 3

SIL 3

PL e

Kategorie 4

PFHD 5 × 10-9 [1/h]

Gebrauchsdauer 20 Jahre

STO-Abschaltzeit < 50 ms

SS1-Verzögerungszeit 10 – 655350 ms (± 1 %)

Tab. 1: SY6 – Sicherheitsrelevante Kenngrößen
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7 Was Sie vor der Inbetriebnahme wissen sollten
Nachfolgende Kapitel ermöglichen Ihnen einen schnellen Einstieg in den Aufbau der Programmoberfläche sowie die
zugehörigen Fensterbezeichnungen und liefert Ihnen relevante Informationen zum generellen Speichern Ihrer
Projektierung.

7.1 Programmoberflächen
Nachfolgende Kapitel beinhalten die Programmoberflächen der beschriebenen Software-Komponenten im Überblick.

7.1.1 DS6: Aufbau der Programmoberfläche
Die Inbetriebnahme-Software DriveControlSuite (DS6) bietet Ihnen eine grafische Oberfläche, über die Sie Ihr Achsmodell
schnell und effizient projektieren, parametrieren und in Betrieb nehmen können.

1

2

3

4

5 6

Abb. 2: DS6: Programmoberfläche

1 Projektbaum

2 Projektmenü

3 Arbeitsbereich

4 Parameterbeschreibung

5 Parameterprüfung

6 Meldungen
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7.1.2 TwinCAT 3: Aufbau der Programmoberfläche
In TwinCAT 3 nehmen Sie Ihr EtherCAT-System über TwinCAT XAE in Betrieb. Die für diese Dokumentation relevanten
Oberflächenelemente entnehmen Sie nachfolgender Grafik.

1

2

3

4

5 6

Abb. 3: TwinCAT 3 (TwinCAT XAE) – Programmoberfläche

1 Solution Explorer

2 Hauptfenster

3 Message-Ansicht

4 Toolbox

5 Ereignisanzeige

6 Statusanzeige (Config-, Run-, Verbindungsaufbau-/Timeout-Modus)

7.2 Netzausfallsicheres Speichern
Sämtliche Projektierungen, Parametrierungen und damit verbundene Änderungen an Parameterwerten sind nach der
Übertragung an den Antriebsregler wirksam, aber noch nicht nichtflüchtig gespeichert.

Sie speichern die Daten über die Funktion Werte speichern in Parameter A00 (Projektmenü > Bereich Assistenten >
projektierte Achse > Assistent Werte speichern).

Erst dann sind die Daten netzausfallsicher hinterlegt.
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8 Inbetriebnahme
Nachfolgende Kapitel beinhalten die Inbetriebnahme Ihres Antriebsreglers und des Sicherheitsmoduls SY6 mithilfe der
STÖBER Software DriveControlSuite sowie dem TwinSAFE-Konfigurator von TwinCAT 3 der Beckhoff Automation GmbH &
Co. KG.

Um die einzelnen Inbetriebnahmeschritte exakt nachvollziehen zu können, setzen wir folgende beispielhafte
Systemumgebung voraus:

§ Beckhoff CX2030 – CPU Grundmodul (Steuerung, EtherCAT-Master)

§ Beckhoff TwinSAFE-Logic-Klemme EL6900 (Sicherheitssteuerung, FSoE-Master)

§ Beckhoff Buskoppler EK1100 (EtherCAT-Buskoppler)

§ Beckhoff TwinSAFE 4-Kanal-Digital-Eingangsklemme EL1904 (digitale Klemme mit 4 fehlersicheren Eingängen)

§ Beckhoff Automatisierungs-Software TwinCAT 3: TwinCAT System Manager (TwinSAFE-Konfigurator), TwinCAT XAE

§ STÖBER Antriebsregler der Baureihe SC6 oder SI6 mit integriertem Sicherheitsmodul SY6

§ STÖBER Inbetriebnahme-Software DriveControlSuite ab Version 6.4-D

Information

Die Inbetriebnahme des Antriebsreglers und des Sicherheitsmoduls SY6 in Kombination mit dem STÖBER Motion Controller
MC6 und der STÖBER Entwicklungsumgebung AutomationControlSuite (AS6) ist in Vorbereitung.

Die Inbetriebnahme gliedert sich in folgende Schritte ...

1. Sicherheitsmodul SY6
Vergeben Sie eine gültige FSoE-Adresse.

2. Beachten Sie für die nachfolgende Konfiguration die Empfehlungen zu den Zeiteinstellungen.

3. DriveControlSuite
Konfigurieren Sie sämtliche Antriebsregler inklusive Sicherheitsmodule, Gerätesteuerungen, Prozessdaten für die
Feldbuskommunikation sowie die Achsen Ihres Antriebssystems in der DriveControlSuite. Erzeugen Sie eine ESI-Datei
und übertragen Sie im Anschluss Ihre Projektkonfiguration auf die Antriebsregler des Systemverbunds.

4. TwinCAT 
Stellen Sie die generierte ESI-Datei TwinCAT 3 zur Verfügung. Bilden Sie anschließend Ihre gesamte Hardware-
Umgebung ab und konfigurieren Sie diese. Nehmen Sie im Anschluss Ihr System in Betrieb und überprüfen Sie die
TwinSAFE-Kommunikation der Systemteilnehmer.

8.1 SY6: FSoE-Adresse vergeben
Um das Sicherheitsmodul SY6 eindeutig im FSoE-Netzwerk identifizieren zu können, müssen Sie diesem eine im FSoE-
Netzwerk eindeutige Adresse zuweisen. Die Adresse ergibt sich aus den Wertigkeiten der DIP-Schalter, die auf ON
geschaltet sind (nähere Informationen hierzu siehe Kapitel SY6: FSoE-Adresse vergeben [} 45]).

Information

Beachten Sie, dass der Antriebsregler ausgeschaltet sein muss, bevor Sie die FSoE-Adresse über den DIP-Schalter vergeben.
Die Adresse wird ausschließlich mit einem Neustart des Antriebsreglers übernommen.
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8.2 Empfohlene Zeiteinstellungen
Um sicherzustellen, dass im Falle eines Schnellhalts mit anschließendem STO (Stopp-Kategorie 1 nach DIN EN 60204-1 bzw.
Safe Stop 1 (SS1) nach DIN EN 61800 5 2) oder bei Unterbrechung der Kommunikation während des gesteuerten
Abbremsens das Leistungsteil nicht abgeschaltet wird und die Achsbewegung nicht mehr durch den Antriebsregler
gesteuert wird, muss die sich ergebende Verzögerungszeit bei Schnellhalt (Schnellhaltzeit) bei der Parametrierung der SS1-
Verzögerungszeit und der FSoE-Watchdog-Zeit berücksichtigt werden.

Schnellhaltzeit

Die Schnellhaltzeit ergibt sich aus der applikationsspezifischen Schnellhaltverzögerung und der maximalen Geschwindigkeit.
Bei den Applikationen nach CiA 402 parametrieren Sie die Schnellhaltverzögerung in A578 Quick stop deceleration. Die
maximale Geschwindigkeit parametrieren Sie in I10 Maximale Geschwindigkeit.

SS1-Verzögerungszeit

Stellen Sie für T_SS1 im FSoE-Master einen größeren Wert ein als für die sich ergebende Schnellhaltzeit. Die Reserve sollte
in der Regel bei 10 % liegen und 50 ms nicht unterschreiten. Sie können die SS1-Verzögerungszeit in S593 SS1 time to STO
überprüfen.

FSoE-Watchdog-Zeit

Stellen Sie für die Watchdog-Zeit im FSoE-Master einen größeren Wert ein als für die sich ergebende Schnellhaltzeit
zuzüglich des PDO Timeouts (A258 EtherCAT PDO-Timeout). Die Reserve sollte in der Regel bei 10 % liegen und 100 ms nicht
unterschreiten. Sie können die Watchdog-Zeit in S27 FSoE-Watchdog-Zeit überprüfen. Bei TwinCAT 3 ist per Default eine
globale Watchdog-Zeit von 100 ms eingestellt. Weitere Informationen zur Watchdog-Zeit finden Sie in Kapitel FSoE-
Watchdog-Zeit [} 46].
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8.3 DS6: Antriebsregler konfigurieren
Projektieren und konfigurieren Sie sämtliche Antriebsregler Ihres Antriebssystems über die DriveControlSuite.

8.3.1 Projekt aufsetzen
Um sämtliche Antriebsregler und Achsen Ihres Antriebssystems über die DriveControlSuite konfigurieren zu können,
müssen Sie diese im Rahmen eines Projekts erfassen.

8.3.1.1 Antriebsregler und Achse projektieren

Neues Projekt erstellen

1. Starten Sie die DriveControlSuite.

2. Klicken Sie auf Neues Projekt erstellen.

ð Das Projektierungsfenster öffnet sich, die Schaltfläche Antriebsregler ist aktiv.

Antriebsregler projektieren

1. Register Eigenschaften: 
Stellen Sie die Beziehung zwischen Ihrem Schaltplan und dem zu projektierenden Antriebsregler in der
DriveControlSuite her.
Referenz: Geben Sie das Referenzkennzeichen (Betriebsmittelkennzeichen) des Antriebsreglers an.
Bezeichnung: Benennen Sie den Antriebsregler eindeutig.
Version: Versionieren Sie Ihre Projektierung.
Beschreibung: Geben Sie gegebenenfalls unterstützende Zusatzinformationen wie die Änderungshistorie der
Projektierung an.

2. Register Antriebsregler:
Wählen Sie die Baureihe und den Gerätetyp des Antriebsreglers.

3. Register Optionsmodule:
Sicherheitsmodul: Wählen Sie Modul SY6.

4. Register Gerätesteuerung:
Gerätesteuerung: Wählen Sie die Gerätesteuerung, die die grundlegenden Ansteuerungssignale des Antriebsreglers
definiert.
Prozessdaten Rx, Prozessdaten Tx: Wählen Sie EtherCAT Rx und EtherCAT Tx für die Übertragung der EtherCAT-
Prozessdaten.
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Achse projektieren

1. Klicken Sie auf Achse 1.

2. Register Eigenschaften: 
Stellen Sie die Beziehung zwischen Ihrem Schaltplan und der zu projektierenden Achse in der DriveControlSuite her.
Referenz: Geben Sie das Referenzkennzeichen (Betriebsmittelkennzeichen) der Achse an.
Bezeichnung: Benennen Sie die Achse eindeutig.
Version: Versionieren Sie Ihre Projektierung.
Beschreibung: Geben Sie gegebenenfalls unterstützende Zusatzinformationen wie beispielsweise die
Änderungshistorie der Projektierung an.

3. Register Applikation: 
Wählen Sie die gewünschte steuerungsbasierende Applikation.
Wenn Sie mit Hard- und Software-Produkten der Firma Beckhoff arbeiten, empfehlen wir CiA 402 (inkrementelle
Version).

4. Register Motor: 
Wählen Sie den Motortyp, den Sie über diese Achse betreiben. Wenn Sie mit Motoren von Fremdanbietern arbeiten,
geben Sie die zugehörigen Motordaten zu einem späteren Zeitpunkt an.

5. Wiederholen Sie die Schritte 2 – 4 für die 2. Achse (nur bei Doppelachsreglern).

6. Bestätigen Sie mit OK.

8.3.2 Allgemeine EtherCAT-Einstellungen parametrieren

ü Sie haben im Rahmen der Antriebsregler- und Achsprojektierung unter anderem das Sicherheitsmodul SY6 sowie eine
Gerätesteuerung mit den Prozessdaten EtherCAT Rx und EtherCAT Tx projektiert.

1. Markieren Sie im Projektbaum den betreffenden Antriebsregler und klicken Sie im Projektmenü > Bereich Assistent
auf die erste projektierte Achse.

2. Wählen Sie Assistent EtherCAT.

3. A213 Feldbusskalierung:
Belassen Sie die Default-Einstellung auf 1: Rohwert (Werte werden unverändert durchgereicht).

4. A258 EtherCAT PDO-Timeout:
Um einen Kommunikationsausfall erkennen zu können, überwachen Sie durch die Definition eines PDO-Timeouts das
Eintreffen der zyklischen Prozessdaten. 
Zulässiger Wertebereich: 0 – 65535 ms. 
Beachten Sie:
0 und 65535 = Überwachung ist inaktiv 
1 bis 65531 = Überwachung ist aktiv
65532 = Überwachung aktiv, der Ausfall eines einzelnen Datenpakets wird jedoch ignoriert
65533 = Überwachung aktiv, der Ausfall von 3 Datenpaketen in Folge wird jedoch ignoriert
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8.3.3 PDO-Übertragung konfigurieren
PDO-Kanäle dienen der Echtzeitübertragung von Steuer- und Statusinformationen sowie Ist- und Sollwerten von einem
EtherCAT-Master zu den EtherCAT-Slaves und umgekehrt.

Die PDO-Kommunikation erlaubt pro Sende- und Empfangsrichtung den gleichzeitigen Betrieb mehrerer PDO-Kanäle. Die
Kanäle für die Achsen A und B beinhalten jeweils ein PDO mit maximal 24 zu übertragenden Parametern in einer definierten
Reihenfolge. Diese sind frei konfigurierbar. Ein Kanal ist für die FSoE-Kommunikation reserviert und wird automatisch
parametriert.

Um die einwandfreie Kommunikation zwischen Steuerung und Antriebsregler zu gewährleisten, bietet STÖBER eine
applikationsabhängige Vorbelegung der Kanäle an, die jederzeit verändert werden kann.

8.3.3.1 RxPDO anpassen

ü Sie haben die globalen EtherCAT-Einstellungen konfiguriert.

1. Markieren Sie im Projektbaum den betreffenden Antriebsregler und klicken Sie im Projektmenü > Bereich Assistent
auf die erste projektierte Achse.

2. Wählen Sie Assistent EtherCAT > Empfangs-Prozessdaten RxPDO.

3. Überprüfen Sie die Default-Einstellungen und/oder konfigurieren Sie die Prozessdaten Ihren Anforderungen
entsprechend.
A225[0] – A225[23], A226[0] – A226[23]:
Parameter, deren Werte der jeweilige Antriebsregler von der Steuerung empfängt. Die Position der Parameter gibt
Auskunft über die zugehörige Empfangsreihenfolge.

8.3.3.2 TxPDO anpassen

ü Sie haben die globalen EtherCAT-Einstellungen konfiguriert.

1. Markieren Sie im Projektbaum den betreffenden Antriebsregler und klicken Sie im Projektmenü > Bereich Assistent
auf die erste projektierte Achse.

2. Wählen Sie Assistent EtherCAT > Sende-Prozessdaten TxPDO.

3. Überprüfen Sie die Default-Einstellungen und/oder konfigurieren Sie die Prozessdaten Ihren Anforderungen
entsprechend.
A233[0] – A233[23], A234[0] – A234[23]: 
Parameter, deren Werte der jeweilige Antriebsregler an die Steuerung versendet. Die Position der Parameter gibt
Auskunft über die zugehörige Sendereihenfolge.
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8.3.4 Konfiguration übertragen und speichern
Um die Konfiguration auf einen oder mehrere Antriebsregler zu übertragen und zu speichern, muss sich Ihr PC mit den
jeweiligen Geräten im selben Netzwerk befinden.

Konfiguration übertragen

ü Die Antriebsregler sind betriebsbereit.

1. Markieren Sie im Projektbaum das Modul, unter dem Sie Ihre Antriebsregler erfasst haben, und klicken Sie im
Projektmenü auf Zuordnung und Live-Firmware-Update.

ð Das Fenster Verbindung hinzufügen öffnet sich. Alle via IPv4-Limited-Broadcast gefundenen Antriebsregler werden
angezeigt.

2. Register Direktverbindung > Spalte IP-Adresse: 
Aktivieren Sie die betreffende IP-Adresse oder aktivieren Sie alle gelisteten über das Kontextmenü. Bestätigen Sie Ihre
Auswahl mit OK.

ð Das Fenster Zuordnung und Live-Firmware-Update öffnet sich. Sämtliche Antriebsregler, die über die zuvor
ausgewählten IP-Adressen angeschlossen sind, werden angezeigt.

3. Wählen Sie den Antriebsregler, auf den Sie eine Konfiguration übertragen möchten. Ändern Sie die Auswahl der
Übertragungsart von Lesen in Senden.

4. Ändern Sie die Auswahl Neuen Antriebsregler anlegen:
Wählen Sie die Konfiguration, die Sie an den Antriebsregler übertragen möchten.

5. Wiederholen Sie die Schritte 3 und 4 für alle weiteren Antriebsregler, auf die Sie eine Konfiguration übertragen
möchten.

6. Register Online:
Klicken Sie auf Online-Verbindungen herstellen.

ð Die Konfigurationen werden an die Antriebsregler übertragen.

Information

Bei der Suche werden via IPv4-Limited-Broadcast alle Antriebsregler innerhalb der Broadcast-Domain ausfindig gemacht.

Voraussetzungen für das Auffinden eines Antriebsregler im Netzwerk:

▪ Netzwerk unterstützt IPv4-Limited-Broadcast

▪ Alle Antriebsregler sind im selben Subnetz (Broadcast-Domain)

Konfiguration speichern

ü Sie haben die Konfiguration erfolgreich übertragen.

1. Fenster Zuordnung und Live-Firmware-Update:
Klicken Sie auf Werte speichern (A00) ....

ð Das Fenster Werte speichern (A00) öffnet sich.

2. Klicken Sie auf Aktion starten.

ð Die Konfiguration wird gespeichert.

3. Schließen Sie das Fenster Werte speichern (A00).

4. Fenster Zuordnung und Live-Firmware-Update: 
Klicken Sie auf Neu starten (A09) ....

ð Das Fenster Neu starten (A09) öffnet sich.
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5. Klicken Sie auf Aktion starten.

6. Bestätigen Sie den Sicherheitshinweis mit OK.

ð Das Fenster Neu starten (A09) schließt sich.

ð Die Feldbuskommunikation und die Verbindung zur DriveControlSuite werden unterbrochen.

ð Die Antriebsregler starten neu.

8.3.5 ESI-Datei erstellen und speichern
Die Funktionen und Eigenschaften der STÖBER Antriebsregler sind in Form unterschiedlicher Objekte beschrieben und in
einer ESI-Datei zusammengefasst. 
Um einen oder mehrere Antriebsregler im Netzwerk abbilden und konfigurieren zu können, generieren Sie eine ESI zu Ihrer
projektierten Applikation und stellen diese dem TwinCAT System Manager in dem nachfolgend angegebenen Verzeichnis
zur Verfügung.

Information

Beachten Sie, dass TwinCAT nur eine ESI-Datei pro Baureihe des Antriebsreglers einlesen kann.
Nach jeder Änderung einer Konfiguration muss eine neue ESI-Datei generiert und diese TwinCAT zur Verfügung gestellt
werden.

ü Sie haben die PDO-Übertragung konfiguriert.

1. Markieren Sie im Projektbaum den betreffenden Antriebsregler und klicken Sie im Projektmenü > Bereich Assistent
auf die erste projektierte Achse.

2. Wählen Sie Assistent EtherCAT.

3. Klicken Sie auf ESI erstellen.

ð Der Dialog Schreibe ESI-Datei öffnet sich.

4. Speichern Sie die XML-Datei in das Verzeichnis C:\TwinCAT\IO\EtherCAT (Standardinstallation).

ð TwinCAT liest die Datei bei einem erneuten Programmstart ein.
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8.4 TwinCAT 3: EtherCAT-System in Betrieb nehmen
TwinCAT 3 bietet Ihnen die Möglichkeit, Ihre Hardware-Umgebung über den TwinCAT XAE abzubilden. 
Sie parametrieren in der Software automatisch per Hardware-Scan sämtliche notwendigen Busparameter. Anschließend
konfigurieren Sie ein individuelles Sicherheitsprogramm, das die Sicherheitsanforderungssignale STO und SS1 bedient. 
Hierfür stehen Ihnen vordefinierte Funktionsbausteine zur Verfügung, die Sie mit den gewünschten Ein- und Ausgängen
verknüpfen. Die Konfiguration eines Sicherheitsprogramms ist nachfolgend am Beispiel von Funktionsbaustein safeEstop
(Emergency Stop) beschrieben.
Das fertige Sicherheitsprogramm übertragen Sie schließlich auf den FSoE-Master.

Beachten Sie, dass alle FSoE-Systemteilnehmer über eine individuelle FSoE-Adresse (Einstellung via DIP-Schalter) im
EtherCAT-Netzwerk eindeutig identifizierbar sein müssen. Vergeben Sie die FSoE-Adressen, bevor Sie die einzelnen Geräte
und Klemmen einbauen und untereinander vernetzen.

Information

Führen Sie die in nachfolgenden Kapiteln enthaltenen Schritte unbedingt in der angegebenen Reihenfolge aus!

Einige Parameter der DriveControlSuite stehen in Abhängigkeit zueinander und werden Ihnen erst zugänglich, wenn Sie
zuvor bestimmte Einstellungen getroffen haben. Folgen Sie den Schritten in der vorgegebenen Reihenfolge, damit Sie die
Parametrierung vollständig abschließen können.

8.4.1 EtherCAT-Master aktivieren

ü Sie haben sämtliche Antriebsregler Ihres Systems über die DriveControlSuite im Vorfeld projektiert und die
Projektkonfiguration auf die einzelnen Antriebsregler übertragen. Der EtherCAT-Master ist an das Netzwerk
angeschlossen, alle Safety-Komponenten besitzen eine FSoE-Adresse, sind mit Spannung versorgt und die
Infrastruktur ist betriebsbereit. Sie haben die generierte ESI-Datei im angegebenen Verzeichnis gespeichert. Die ESI-
Dateien der Beckhoff-Geräte sind bereits im TwinCAT-System hinterlegt.

1. Starten Sie TwinCAT XAE.

ð Die hinterlegte ESI-Datei wird mit dem Programmstart eingelesen und das Hauptfenster des TwinCAT System
Managers öffnet sich. Register Start Page ist aktiv.

2. Wählen Sie File > New > Project.

ð Der Dialog New Project öffnet sich.

3. Wählen Sie Installed > Templates > TwinCAT Projects > TwinCAT XAE Project (XML format).

4. Name, Location, Solution name: 
Benennen Sie das Projekt, geben Sie einen Speicherort und einen internen Projektnamen an.

5. Schließen Sie den Dialog.

6. Wurden Run-Time (EtherCAT-Master) und TwinCAT XAE auf einem PC installiert, sind diese automatisch miteinander
verbunden. Fahren Sie mit Schritt 12 fort.

7. Wurden Run-Time (EtherCAT-Master) und TwinCAT System Manager auf unterschiedlichen PCs installiert, müssen Sie
diese miteinander verbinden. 
Klicken Sie in der TwinCAT XAE-Toolbar auf das Listenfeld <Local> und wählen Sie Choose Target System.

ð Der Dialog Choose Target System öffnet sich.

8. Klicken Sie auf Search (Ethernet).

ð Der Dialog Add Route öffnet sich.

9. Klicken Sie auf Broadcast Search.

ð Sämtliche verfügbaren Steuerungen sind gelistet.
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10. Markieren Sie die gewünschte Steuerung, aktivieren Sie die Option IP Address und bestätigen Sie mit Add Route.

ð Der Dialog Logon Information öffnet sich.

11. Geben Sie bei einem Neugerät folgende Daten ein (TwinCAT-Standardzugriff) und bestätigen Sie mit OK:
User name: Administrator
Password: 1

12. Schließen Sie den Dialog.

13. Dialog Choose Target System: 
Markieren Sie den zuvor gewählten EtherCAT-Master und bestätigen Sie mit OK.

ð Der EtherCAT-Master ist als Zielsystem gespeichert.

14. Um das EtherCAT-System online konfigurieren zu können, müssen Sie den Konfigurationsmodus (Config-Modus) der
TwinCAT XAE-Software aktivieren. 
Wählen Sie Menü TWINCAT > Restart TwinCAT (Config Mode).

ð Der Dialog Restart TwinCAT System in Config Mode öffnet sich.

15. Bestätigen Sie mit OK.

ð Der EtherCAT-Master ist als Zielsystem gespeichert, TwinCAT XAE befindet sich im Config-Modus.

8.4.2 Hardware-Umgebung scannen
Sind alle Systemkomponenten am EtherCAT-Netzwerk angeschlossen und ist dieses mit Spannung versorgt, besteht die
Möglichkeit, automatisch nach Systemteilnehmern zu scannen. In diesem Fall sucht TwinCAT XAE nach verbundenen
Geräten und Klemmen und integriert diese, gemäß deren Konfigurationseinträgen in den zugehörigen ESI-Dateien, in das
bestehende Projekt.

Steht Ihnen die reale EtherCAT-Infrastruktur nicht zur Verfügung, d. h. Sie konfigurieren im Offline-Modus, müssen Sie
sämtliche Systemteilnehmer manuell in TwinCAT XAE abbilden und projektieren. Nähere Informationen hierzu erhalten Sie
in der Online-Hilfe der TwinCAT XAE-Software.

ü Sie haben den Config-Modus aktiviert.

1. Navigieren Sie im Solution Explorer zu I/O > Devices > Kontextmenü Scan.

ð TwinCAT XAE scannt das EtherCAT-System nach dem EtherCAT-Master. 
Der Dialog ... new I/O devices found öffnet sich.

2. Aktivieren Sie den betreffenden EtherCAT-Master und bestätigen Sie mit OK.

ð Der EtherCAT-Master wird im Solution Explorer unter I/O > Devices als Device (EtherCAT) angelegt. 
Der Dialog Scan for boxes? öffnet sich.

3. Bestätigen Sie mit Yes.

ð TwinCAT XAE scannt das EtherCAT-System nach EtherCAT-Slaves.
Der Dialog EtherCAT driv(es) added öffnet sich.

4. Append linked axis to:
Wenn Sie eine NC-oder CNC-Funktionalität benötigen, aktivieren Sie die gewünschte Option und bestätigen Sie mit
OK.

ð Im Solution Explorer werden die EtherCAT-Slaves Buskoppler (Klemme EK1100) samt FSoE-Master (Klemme
EL6900) und den sicheren Eingängen (Klemmen EL1904) sowie der Antriebsregler angelegt. 
Der Dialog Activate Free Run öffnet sich.

5. Um die Systemkomponenten während deren Konfiguration in einen Freilaufmodus (Free Run) zu versetzen und somit
den Signalaustausch verifizieren zu können, bestätigen Sie mit Yes.

ð EtherCAT-Master und -Slaves sind in TwinCAT XAE angelegt.
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8.4.3 TwinCAT SAFETY-Projekt konfigurieren
Ein TwinCAT SAFETY-Projekt besteht aus einer TwinSAFE-Gruppe mit Alias-Devices, d. h. den Hardware-Komponenten Ihres
Systems sowie dem eigentlichen SAFETY-Element samt zugehörigen Funktionsbausteinen, die die sicherheitsgerichtete
Logik darstellen. Die Funktionsbausteine besitzen Parameter, die anwendungsspezifisch eingerichtet werden müssen.

Legen Sie im ersten Schritt ein SAFETY-Projekt samt Alias-Devices an und konfigurieren Sie im Anschluss beispielhaft den
Funktionsbaustein safeEstop.

8.4.3.1 TwinCAT SAFETY-Projekt anlegen

1. Navigieren Sie im Solution Explorer zu SAFETY > Kontextmenü Add New Item.

ð Der Dialog Add New Item öffnet sich.

2. Markieren Sie den Eintrag TwinCAT Default Safety Project.

3. Name: 
Benennen Sie das SAFETY-Projekt und bestätigen Sie mit Add.

ð Der Dialog TwinCAT Safety Project Wizard öffnet sich.

4. Internal Project Name: 
Vergeben Sie gegebenenfalls einen systeminternen Projektnamen und bestätigen Sie mit OK.

ð Im Solution Explorer werden das SAFETY-Projekt unter dem von Ihnen vergebenen Namen, ein Zielsystem sowie
eine TwinSAFE-Gruppe angelegt. Die TwinSAFE-Gruppe beinhaltet bereits einen Ordner für die noch anzulegenden
Alias-Devices; das Alias-Device ErrorAcknowledgement.sds als Reset-Eingang ist im Standard vorhanden.

5. Um den FSoE-Master als Zielsystem zu definieren, wählen Sie im Solution Explorer das neu angelegte SAFETY-Projekt
und doppelklicken Sie auf Target System.

6. Hauptfenster > Physical Device: 
Klicken Sie auf das zugehörige Icon.

ð Der Dialog Choose physical terminal for mapping öffnet sich.

7. Terminal: 
Markieren Sie den FSoE-Master EL6900 und bestätigen Sie mit OK.

8. Hauptfenster > Hardware Address: 
Die FSoE-Adresse des FSoE-Mastern wurde automatisch in TwinCAT XAE eingelesen.

9. Um das Projekt zu speichern, wählen Sie Menü FILE > Safe Selected Items.

ð Das SAFETY-Projekt ist angelegt und der FSoE-Master als zugehöriges Zielsystem konfiguriert.
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8.4.3.2 Alias-Devices anlegen

Die für das SAFETY-Projekt benötigte Hardware wird als jeweiliges Alias-Device in die TwinSAFE-Gruppe eingebunden.

1. Navigieren Sie im Solution Explorer zu Ihrem SAFETY-Projekt > TwinSafeGroup1 > Alias Devices > Kontextmenü Add >
New Item.

ð Der Dialog Add New Item öffnet sich.

2. Legen Sie ein Alias-Device als Eingang für den Start der TwinSAFE-Gruppe an. 
Wählen Sie  Installed > Standard  > 1 Digital Input (Standard).

3. Name: 
Benennen Sie das Alias-Device mit RUN und bestätigen Sie mit Add.

4. Wählen Sie im Solution Explorer erneut Ordner Alias Devices > Kontextmenü Add > New Item.

5. Legen Sie ein Alias-Device für die sicheren Eingänge (Klemme EL1904) an. 
Wählen Sie  Safety  > EtherCAT > Beckhoff Automation GmbH > 4 Digital Inputs.

6. Name: 
Benennen Sie gegebenenfalls das Device und bestätigen Sie mit Add.

7. Wählen Sie im Solution Explorer erneut Ordner Alias Devices > Kontextmenü Add > New Item.

8. Legen Sie ein Alias-Device für den Antriebsregler mit dem integrierten Sicherheitsmodul SY6 an. 
Wählen Sie  Safety  > EtherCAT > STOEBER ANTRIEBSTECHNIK GmbH & Co. KG > 0xB1EC5956 - Safety (FSoE).

9. Name: 
Benennen Sie gegebenenfalls das Device und bestätigen Sie mit Add.

ð Die genannten Hardware-Komponenten sind im Solution Explorer als Alias-Devices der TwinSAFE-Gruppe angelegt.

8.4.3.3 Alias-Devices zuordnen und FSoE-Adressen eintragen

Ordnen Sie die angelegten Alias-Devices den einzelnen Hardware-Komponenten Ihres Systems zu und vergeben Sie die
zugehörigen FSoE-Adressen.

1. Navigieren Sie im Solution Explorer zu Ihrem SAFETY-Projekt > TwinSafeGroup1 > Alias Devices und doppelklicken Sie
auf ErrorAcknowledgement.sds.

2. Hauptfenster > Full Name: 
Klicken Sie auf das zugehörige Icon.

ð Der Dialog Attach Variable Standard In Var 1 (Output) öffnet sich.

3. Show Variables:
Um sämtliche Geräte anzuzeigen, aktivieren Sie die Option Used and unused.

4. Show Variables: 
Um die Standardeingänge anzuzeigen, deaktivieren Sie die Checkbox Exclude other Devices.

5. Wählen Sie den gewünschten Standardeingang für den Reset der TwinSAFE-Gruppe und bestätigen Sie mit OK.

6. Wählen Sie im Solution Explorer Ordner Alias Devices und doppelklicken Sie auf RUN.sds.

7. Hauptfenster > Full Name: 
Klicken Sie auf das zugehörige Icon.

ð Der Dialog Attach Variable Standard In Var 1 (Output) öffnet sich.

8. Wählen Sie den gewünschten Standardeingang für den Start der TwinSAFE-Gruppe und bestätigen Sie mit OK.

ð Die Hardware-Standardeingänge für Reset und Start der TwinSAFE-Gruppe sind mit den zugehörigen Alias-Devices
verknüpft.

9. Wählen Sie im Solution Explorer Ordner Alias Devices und doppelklicken Sie auf 4 digital inputs_1.sds.
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10. Hauptfenster > Register Linking > Physical Device: 
Klicken Sie auf das zugehörige Icon.

ð Der Dialog Choose physical channel öffnet sich.

11. Wählen Sie das erste Modul der Klemme EL1904 und bestätigen Sie mit OK.

ð Klemme EL1904 ist mit dem entsprechenden Alias-Device verknüpft.

12. Register Linking > FSoE Address: 
Die FSoE-Adresse der Klemme EL1904 wurde durch den Hardware-Scan automatisch in TwinCAT XAE, Feld Dip Switch
eingelesen. Um die Adresse zu übernehmen, klicken Sie auf das zugehörige Icon.

ð Die Adresse wird aus dem Feld Dip Switch in Feld FSoE Address übernommen.

13. Wählen Sie im Solution Explorer Ordner Alias Devices und doppelklicken Sie auf 0xB1EC5956 – Safety(FSoE).sds.

14. Hauptfenster > Register Linking > Physical Device: 
Klicken Sie auf das zugehörige Icon.

ð Der Dialog Choose physical channel öffnet sich.

15. Wählen Sie das erste Modul des Antriebsreglers mit dem integrierten Sicherheitsmodul SY6 und bestätigen Sie mit OK.

ð Der Antriebsregler ist mit dem entsprechenden Alias-Device verknüpft.

16. Register Linking > FSoE Address: 
Die FSoE-Adresse des Sicherheitsmoduls wurde durch den Hardware-Scan automatisch in TwinCAT XAE, Feld Dip
Switch eingelesen. Um die Adresse zu übernehmen, klicken Sie auf das zugehörige Icon.

ð Die Adresse wird aus dem Feld Dip Switch in Feld FSoE Address übernommen.

17. Um die SS1-Verzögerungszeit, nach deren Ablauf automatisch die Funktion STO ausgelöst wird, zu parametrieren,
wählen Sie im Hauptfenster > Register Safety Parameters > Parameter T_SS1.

18. T_SS1:
Doppelklicken Sie auf den Eintrag.

ð Dialog Set Value öffnet sich.

19. Dec.:
Parametrieren Sie die gewünschte SS1-Verzögerungszeit und bestätigen Sie mit OK.

ð Beachten Sie, dass der hier parametrierte Wert systemintern mit Faktor 10 multipliziert wird (Bsp.: T_SS1 = 100,
entspricht 1000 ms). 
T_SS1 wird in Parameter S593 SS1 time to STO der DriveControlSuite angezeigt.

ð Die Hardware-Komponenten sind mit den entsprechenden Alias-Devices verknüpft und die FSoE-Adressen
eingetragen.
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8.4.3.4 Funktionsbaustein konfigurieren

Konfigurieren Sie via Funktionsbaustein safeEstop einen Not-Halt-Taster, der über zwei Öffnerkontakte mit der sichere
Eingangsklemme EL1904 verbunden ist.

8.4.3.4.1 Funktionsbaustein anlegen und Signalquellen zuweisen

1
3

2

4 5

Abb. 4: TwinCAT 3 – Funktionsbaustein "safeEstop" konfigurieren und Signalquellen zuweisen

1. Navigieren Sie im Solution Explorer zu Ihrem SAFETY-Projekt > TwinSafeGroup1 und doppelklicken Sie auf
TwinSafeGroup1.sal (1).

2. Menü VIEW (2): 
Öffnen Sie die Ansicht Toolbox.

3. Toolbox > FunctionBlocks (boolean) (3): 
Ziehen Sie den Funktionsbaustein safeEstop per Drag & Drop in das Hauptfenster > Register TwinSafeGroup1.sal.

4. Klicken Sie links neben dem Icon zu Restart.

5. Benennen Sie die Variable mit RestartInput.

6. Klicken Sie jeweils links neben den Icons zu EStopIn1 und EStopIn2.

7. Benennen Sie die Variablen mit Channel1 und Channel2.

8. Klicken Sie jeweils rechts neben den Icons zu EStopOut und EStopDelOut.

9. Benennen Sie die Variablen mit Stop und StopVerz.
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10. Delay Time (ms): 
Geben Sie die in T_SS1  parametrierte SS1-Verzögerungszeit an. 
Beachten Sie, dass der Wert in diesem Eingabefeld NICHT systemintern mit Faktor 10 multipliziert wird.

ð Alle notwendigen Variablen für die Konfiguration des Funktionsbausteins safeEstop sind angelegt.

11. Wechseln Sie in der Message-Ansicht in Register Variable Mapping > Subregister Variables (4).

ð Die zuvor für den Funktionsbaustein definierten Variablen sind in Spalte Assigned Variable gelistet.

12. Variable RestartInput > Spalte Alias Port: 
Klicken Sie auf die zugehörige Schaltfläche.

ð Der Dialog Map to öffnet sich.

13. Usage: 
Aktivieren Sie die Option Used and unused.

14. Ordnen Sie der Variable das Alias Device ErrorAcknowledgement zu und bestätigen Sie mit OK.

15. Subregister Variables > Variablen Channel1 und Channel2 > Spalte Alias Port: 
Klicken Sie auf die zugehörigen Schaltflächen.

ð Der Dialog Map to öffnet sich.

16. Ordnen Sie der Variable Channel1 das Alias Devices 4 digital inputs > Channel1 > InputChannel1 und Variable Channel2
4 digital inputs > Channel2 > InputChannel2 zu und bestätigen Sie mit OK.

17. Subregister Variables > Variablen Stop und StopVerz > Spalte Alias Port: 
Klicken Sie auf die zugehörigen Schaltflächen.

ð Der Dialog Map to öffnet sich.

18. Ordnen Sie der Variable Stop das Alias Device 0xB1EC5956 - Safety (FSoE)  > Channel > SS1 und Variable StopVerz das
Alias Device 0xB1EC5956 - Safety (FSoE)  > Channel > STO zu bestätigen Sie mit OK.

ð Alle konfigurierten Variablen des Funktionsbausteins safeEstop sind mit den zugehörigen Alias Devices verknüpft.

19. Wechseln Sie in Subregister Group Ports (5).

20. Variablen ErrAck und Run/Stop > Spalte Alias Port: 
Klicken Sie auf die zugehörigen Schaltflächen.

ð Der Dialog Map to öffnet sich.

21. Usage: 
Aktivieren Sie die Option Used and unused.

22. Ordnen Sie den Variablen jeweils die Alias Devices ErrorAcknowledgement und RUN der TwinSAFE-Gruppe zu und
bestätigen Sie mit OK

ð Der konfigurierte Funktionsbaustein ist bereit zum Download auf den FSoE-Master.
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8.4.3.4.2 Funktionsbaustein übertragen

Validieren Sie den konfigurierten Funktionsbaustein und übertragen Sie diesen auf den FSoE-Master.

1. Navigieren Sie im Solution Explorer zu Ihrem SAFETY-Projekt > TwinSafeGroup1 und doppelklicken Sie auf
TwinSafeGroup1.sal.

2. Wählen Sie Menü TWINSAFE > Verify Complete Safety Project.

3. War die Validierung erfolgreich, wird der Status VERIFICATION PROCESS SUCCEEDED im linken Bereich der Fußzeile der
TwinCAT XAE-Oberfläche angezeigt.

4. Wählen Sie Menü TWINSAFE > Download Safety Project.

ð Der Dialog Check if the addresses configured on hardware terminals [...] öffnet sich.

5. Bestätigen Sie die Abfrage mit Yes.

ð Der Dialog Download Project Data > Steps: Login öffnet sich. 
Der Download auf den FSoE-Master ist durch ein Passwort geschützt.

6. Bereich Login:
Geben Sie bei einem Neugerät folgende Daten an (TwinCAT-Standardzugriff) und bestätigen Sie mit Next: 
Username: Administrator
Serial Number: Seriennummer des FSoE-Masters
Password: TwinSAFE

ð Der Dialog Download Project Data > Steps: Download öffnet sich.

7. Stoßen Sie den Download mit einem Klick auf Next an.

ð Der Dialog Download Project Data > Steps: Final Verification öffnet sich.

8. Bereich Final Verification > Sicherheitsabfrage  I have manually verified the data shown [...]:
Prüfen Sie die konfigurierten Daten, bestätigen Sie die Sicherheitsabfrage durch Aktivieren der zugehörigen Checkbox
und klicken Sie auf Next.

ð Der Dialog Download Project Data > Steps: Activation öffnet sich.

9. Bereich Activation > Password: 
Geben Sie das Passwort TwinSAFE erneut ein und bestätigen Sie mit Finish.

ð Der Funktionsbaustein wird auf den FSoE-Master übertragen.

10. Starten Sie das TwinCAT-System neu: 
Wählen Sie Menü Actions > Set/Reset TwinCAT to Config Mode.

ð Der Dialog Restart TwinCAT System in Config Mode öffnet sich.

11. Bestätigen Sie mit OK.

8.4.4 Funktionalität der TwinSAFE-Gruppe prüfen
Prüfen Sie die korrekte Funktionsweise der TwinSAFE-Gruppe.

1. Navigieren Sie im Solution Explorer zu Ihrem SAFETY-Projekt > TwinSafeGroup1 und doppelklicken Sie auf
TwinSafeGroup1.sal.

2. Wählen Sie Menü TWINSAFE > Show Online Data.

ð Der FSoE-Master (Klemme EL6900) ist gestoppt, der Funktionsbaustein safeEstop ist deaktiviert, der zugehörige
Status ist auf Rot gesetzt.

3. Starten Sie die TwinSAFE-Gruppe über RUN = true.

4. Entriegeln Sie den Not-Halt-Taster und drücken Sie die Reset-Taste.

ð Der Funktionsbaustein ist nicht aktiv, die TwinSAFE-Gruppe arbeitet korrekt.
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9 Diagnose
Im Störungsfall stehen Ihnen unterschiedliche, nachfolgend beschriebene Diagnosemöglichkeiten zur Verfügung.

9.1 LED-Anzeige
STÖBER Antriebsregler verfügen über Diagnose-Leuchtdioden, die den Zustand der Feldbuskommunikation sowie die
Zustände der physikalischen Verbindung visualisieren.

9.1.1 Zustand EtherCAT
2 Leuchtdioden auf der Gerätefront des Antriebsreglers geben Auskunft über die Verbindung zwischen EtherCAT-Master
und -Slave sowie über den Zustand des Datenaustauschs. Dieser kann zusätzlich in Parameter A255 EtherCAT Device State
ausgelesen werden. Beinhaltet der Antriebsregler das Sicherheitsmodul SY6, werden die Sicherheitsfunktionen STO und SS1
über EtherCAT FSoE angesteuert. In diesem Fall informiert eine zusätzliche Leuchtdiode auf der Gerätefront über den FSoE-
Zustand.

2

1 Err

Run

FSoE

Abb. 5: Leuchtdioden für den EtherCAT-Zustand

1 Rot: Error

2 Grün: Run



9 | Diagnose STÖBER

34

03
/2

02
0 

| 
ID

 4
42

74
3.

03

Rote LED Verhalten Fehler Beschreibung

Aus No Error Kein Fehler

Blinken Invalid Configuration Ungültige Konfiguration

1-faches Blinken Unsolicited State Change EtherCAT-Slave hat Betriebszustand
selbstständig gewechselt

2-faches Blinken Application Watchdog
Timeout

EtherCAT-Slave hat keine neuen PDO-Daten
während des parametrierten Watchdog-
Timeouts empfangen

Tab. 2: Bedeutung der roten LED (Error)

Grüne LED Verhalten Betriebszustand Beschreibung

Aus Init Keine Kommunikation zwischen EtherCAT-
Master und -Slave; die Konfiguration startet,
gespeicherte Werte werden geladen

Blinken Pre-Operational Keine PDO-Kommunikation; EtherCAT-
Master und -Slave tauschen
applikationsspezifische Parameter über SDO
aus

1-faches Blinken Safe-Operational EtherCAT-Slave sendet aktuelle Istwerte an
den EtherCAT-Master, ignoriert dessen
Sollwerte und greift auf interne Default-
Werte zurück

Ein Operational Normalbetrieb: EtherCAT-Master und -Slave
tauschen Soll- und Istwerte aus

Tab. 3: Bedeutung der grünen LED (Run)
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9.1.2 Zustand FSoE
Beinhaltet der Antriebsregler das Sicherheitsmodul SY6, werden die Sicherheitsfunktionen STO und SS1 über EtherCAT FSoE
angesteuert. In diesem Fall informiert eine Leuchtdiode auf der Gerätefront über den Zustand der FSoE-Kommunikation.
Dieser kann zusätzlich in Parameter S20 FSoE status indicator ausgelesen werden.

1

Err

Run

FSoE

Abb. 6: Leuchtdiode für den FSoE-Zustand

1 Grün: FSoE

Grüne LED Verhalten Beschreibung

Aus Initialisierung

Blinken Bereit für die Parametrierung

Ein Normalbetrieb

1-facher Flash Failsafe-Kommando von FSoE-Master empfangen

Blitzen Undefinierter Verbindungsfehler

Blitzen mit 1-fachem
Blinken

Fehler in den sicherheitsrelevanten Kommunikationseinstellungen

Blitzen mit 2-fachem
Blinken

Fehler in den sicherheitsrelevanten Applikationseinstellungen

Blitzen mit 3-fachem
Blinken

Falsche FSoE-Adresse

Blitzen mit 4-fachem
Blinken

Unerlaubtes Kommando empfangen

Blitzen mit 5-fachem
Blinken

Watchdog-Fehler

Blitzen mit 6-fachem
Blinken

CRC-Fehler

Tab. 4: Bedeutung der grünen LED (FSoE status indicator nach IEC 61784-3)
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9.1.3 Netzwerkverbindung EtherCAT
Die Leuchtdioden LA ECIN und LA ECOUT an X200 und X201 auf der Geräteoberseite zeigen den Zustand der EtherCAT-
Netzwerkverbindung an.

LA
LA

IN
EC

X
2
0
0
:

O
U
T

EC
X
2
0
1
:

2

4

3

1

Abb. 7: Leuchtdioden für den Zustand der EtherCAT-Netzwerkverbindung

1 Grün: LA ECOUT an X201

2 Gelb: Ohne Funktion

3 Grün: LA ECIN an X200

4 Gelb: Ohne Funktion

Grüne LED Verhalten Beschreibung

Aus Keine Neztwerkverbindung

Blinken Aktiver Datenaustausch mit weiterem EtherCAT-Teilnehmer

Ein Netzwerkverbindung besteht

Tab. 5: Bedeutung der grünen LEDs (LA)



STÖBER 9 | Diagnose
03

/2
02

0 
| 

ID
 4

42
74

3.
03

37

9.2 Parameter
Folgende Diagnoseparameter stehen Ihnen bei der Sicherheitstechnik mit Antriebsreglern der Baureihe SC6 oder SI6 und
Sicherheitsmodul SY6 zur Verfügung.

9.2.1 E54 | Information Sicherheitsmodul | V0
Kennzeichnende Daten des Sicherheitsmoduls.

§ [0]: Typ

§ [1]: Hardware-Version

§ [2]: Produktionsnummer

§ [3] – [5]: Reserviert

§ [6]: Diagnose-Code

9.2.2 E67 | STO-Zustand | V1
STO-Zustand des Sicherheitsmoduls:

§ [0]: STO wurde durch das Eingangssignal STOa = 0 oder STOb = 0 ausgelöst

• 0: Inaktiv = nicht ausgelöst

• 1: Aktiv = ausgelöst

§ [1]: STO wurde durch das Eingangssignal STOa = 0 ausgelöst

• 0: Inaktiv = nicht ausgelöst

• 1: Aktiv = ausgelöst

§ [2]: STO wurde durch das Eingangssignal STOb = 0 ausgelöst

• 0: Inaktiv = nicht ausgelöst

• 1: Aktiv = ausgelöst



9 | Diagnose STÖBER

38

03
/2

02
0 

| 
ID

 4
42

74
3.

03

9.2.3 S20 | FSoE status indicator | V0
Zustand der Übertragung sicherheitsrelevanter Daten via FSoE.

Entspricht dem FSoE status indicator nach IEC 61784-3.

Normal
§ 0 hex = Initialisierung

Möglich im FSoE-Zustand Pre-Reset

§ 1 hex = bereit für die Parametrierung durch FSoE-Master
Möglich in den FSoE-Zuständen Reset, Session, Connection, Parameter

§ 2 hex = Normalbetrieb
Möglich im FSoE-Zustand Process Data

§ 3 hex = Failsafe-Kommando von FSoE-Master empfangen
Möglich im FSoE-Zustand Failsafe Data

Fehler
§ 4 hex = undefinierter Verbindungsfehler

Möglich in allen FSoE-Zuständen

§ 5 hex = Fehler in den sicherheitsrelevanten Kommunikationseinstellungen
Möglich im FSoE-Zustand Parameter

§ 6 hex = Fehler in den sicherheitsrelevanten Applikationseinstellungen
Möglich im FSoE-Zustand Parameter

§ 7 hex = falsche FSoE-Adresse 
Möglich im FSoE-Zustand Connection

§ 8 hex = unzulässiges Kommando über die FSoE-Kommunikationsschnittstelle empfangen
Möglich in allen FSoE-Zuständen

§ 9 hex = Timeout der Datenübertragung (Watchdog)
Möglich in allen FSoE-Zuständen

§ A hex = inkonsistente Datenübertragung (CRC-Prüfsumme)
Möglich in allen FSoE-Zuständen

9.2.4 S21 | FSoE-Slave-Adresse | V0
Adresse des Antriebsreglers (FSoE-Slave) im EtherCAT-Netzwerk (Voraussetzung: FSoE-Master ist aktiv; Quelle: DIP-
Schalter).

Adressänderungen werden beim Neustart des Antriebsreglers übernommen.

9.2.5 S25 | Diagnose-Code SY6 | V0
Status-Byte mit Diagnose-Code des Sicherheitsmoduls.

§ Bit 0: Interner OSSD-Kanalfehler

§ Bit 1: Reserviert

§ Bit 2: FSoE-Kommunikationsfehler

§ Bit 3: Reserviert

§ Bit 4: Übertemperatur

§ Bit 5: Reserviert

§ Bit 6: Zeit SS1
0 = läuft nicht; 1 = läuft

§ Bit 7: Zustand STO
1 = in sicherem Zustand

Sofern nicht anders angegeben, gilt: 0 = inaktiv; 1 = aktiv.
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9.2.6 S27 | FSoE-Watchdog-Zeit | V0
Tolerierte Ausfalldauer von FSoE-Telegrammen zur Überwachung der FSoE-Kommunikation im EtherCAT-Netzwerk
(Verwendung: Auslösen internes STO; Quelle: FSoE-Master).

Die FSoE-Überwachung ist unabhängig von der PDO-Überwachung und wird durch den FSoE-Master vorgegeben (PDO-
Überwachung: A258).

9.2.7 S130 | Betriebszeit | V0
Betriebszeit des Sicherheitsmoduls.

9.2.8 S544 | Safety controlword | V0
Steuer-Byte für FSoE.

Entspricht dem Kommunikationsobjekt Safety controlword nach ETG.6100.1; Objekt 6620 hex.

§ [0]: Erstes Byte
Entspricht dem Kommunikationsobjekt 1st byte nach ETG.6100.1; Subindex 1 hex

• Bit 0: STO
0 = STO aktivieren; 1 = STO nicht aktivieren

• Bit 1: SS1
0 = SS1 aktivieren; 1 = SS1 nicht aktivieren

• Bit 2 – 7: Reserviert

§ [1]: Zweites Byte: Reserviert
Entspricht dem Kommunikationsobjekt 1st byte nach ETG.6100.1; Subindex 2 hex

Für die Freigabe des Leistungsteils müssen Bit 0 und Bit 1 auf 1 gesetzt sein.

9.2.9 S545 | Safety statusword | V0
Status-Byte für FSoE.

Entspricht dem Kommunikationsobjekt Safety statusword nach ETG.6100.1; Objekt 6621 hex.

§ [0]: Erstes Byte
Entspricht dem Kommunikationsobjekt 1st byte nach ETG.6100.1; Subindex 1 hex

• Bit 0: STO
1 = STO aktiv

• Bit 1 – 7: Reserviert

§ [1]: Zweites Byte: Reserviert
Entspricht dem Kommunikationsobjekt 1st byte nach ETG.6100.1; Subindex 2 hex

9.2.10 S593 | SS1 time to STO | V0
SS1-Verzögerungszeit, d. h. Zeitdauer zwischen der Aktivierung eines zeitbasierten SS1 durch S544 Safety controlword, Bit 1
und dem internen Auslösen der STO-Funktion (Einheit: 10 ms; Quelle: FSoE-Master).

Entspricht dem Kommunikationsobjekt SS1 time to STO nach ETG.6100.1, Objekt 6651 hex.

Eine Änderung der SS1-Verzögerungszeit im FSoE-Master wird mit dem nächsten Neustart des FSoE-Masters wirksam und in
Parameter S593 sichtbar.
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9.3 Ereignisse
Der Antriebsregler verfügt über ein System zur Selbstüberwachung, das anhand von Prüfregeln das Antriebssystem vor
Schaden schützt. Bei Verletzung der Prüfregeln wird ein entsprechendes Ereignis ausgelöst. Auf manche Ereignisse wie
beispielsweise das Ereignis Kurz-/Erdschluss haben Sie als Anwender keinerlei Einflussmöglichkeit. Bei anderen können Sie
Einfluss auf die Auswirkungen und Reaktionen nehmen.

Mögliche Auswirkungen sind:

§ Meldung: Information, die von der Steuerung ausgewertet werden kann

§ Warnung: Information, die von der Steuerung ausgewertet werden kann und nach Ablauf einer definierten Zeitspanne
zu einer Störung wird, sofern die Ursache nicht behoben wurde

§ Störung: Sofortige Reaktion des Antriebsreglers; das Leistungsteil wird gesperrt und die Achsbewegung nicht mehr
durch den Antriebsregler gesteuert oder die Achse wird durch einen Schnellhalt oder eine Notbremsung zum Stillstand
gebracht

ACHTUNG!

Sachschaden durch Unterbrechung von Schnellhalt oder Notbremsung

Tritt während der Ausführung eines Schnellhalts oder einer Notbremsung eine andere Störung auf oder wird eine
Sicherheitsfunktion aktiviert, wird der Schnellhalt oder die Notbremsung unterbrochen. In diesem Fall kann die Maschine
durch die unkontrollierte Achsbewegung beschädigt werden.

Ereignisse, deren Ursachen sowie geeignete Maßnahmen sind nachfolgend gelistet. Ist die Fehlerursache behoben, können
Sie den Fehler in der Regel direkt quittieren. Ist stattdessen ein Neustart des Antriebsreglers erforderlich, finden Sie einen
entsprechenden Hinweis in den Maßnahmen.

9.3.1 Ereignis 50: Sicherheitsmodul
Der Antriebsregler geht in Störung:

§ Das Leistungsteil wird gesperrt und die Achsbewegung nicht mehr durch den Antriebsregler gesteuert

§ Die Bremsen werden nicht mehr durch den Antriebsregler gesteuert und fallen bei inaktivem Lüft-Override ein (F06)

Ursache Prüfung und Maßnahme

2: Falsches Modul Projektiertes Sicherheitsmodul E53
stimmt nicht mit dem systemseitig
erkannten E54[0] überein

Projektierung und Antriebsregler prüfen und
gegebenenfalls Projektierung korrigieren oder
Antriebsregler tauschen; Störung ist nicht
quittierbar

3: Fehler SY6 Defektes Sicherheitsmodul Antriebsregler tauschen; Störung ist nicht
quittierbar

16: Freigabe aktiv STO-Anforderung bei aktivem
Leistungsteil

STO nur bei inaktivem Leistungsteil anfordern

Zeitgleich mit STO-Anforderung auch Freigabe-
Aus ohne Schnellhalt anfordern (Drive Based
A44)

Tab. 6: Ereignis 50 – Ursachen und Maßnahmen
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9.3.2 Ereignis 70: Parameterkonsistenz
Der Antriebsregler geht in Störung:

§ Das Leistungsteil wird gesperrt und die Achsbewegung nicht mehr durch den Antriebsregler gesteuert

§ Die Bremsen werden nicht mehr durch den Antriebsregler gesteuert und fallen bei inaktivem Lüft-Override ein (F06)

Ursache Prüfung und Maßnahme

15: FSoE-Watchdog-Zeit Zu kleines Verhältnis von FSoE-
Watchdog-Zeit zu EtherCAT PDO-
Timeout

FSoE-Watchdog-Zeit im FSoE-Master und
EtherCAT PDO-Timeout im Antriebsregler
prüfen und gegebenfalls Watchdog-Zeit
erhöhen oder PDO-Timeout reduzieren
(Richtwert: FSoE-Watchdog-Zeit = EtherCAT
PDO-Timeout + 100 ms; S27, A258)

Tab. 7: Ereignis 70 – Ursachen und Maßnahmen

9.4 Parameter vom FSoE-Master
Beim Verbindungsaufbau erwartet das Sicherheitsmodul SY6 im FSoE-Zustand Parameter vom FSoE-Master folgende
Process Data Units (PDU) in der angegebenen Reihenfolge. Process Data Units sind die Datenpakete, die zwischen FSoE-
Master und FSoE-Slave ausgetauscht werden:

PDU Byte Wert Beschreibung

PDU 1 SafeData[0] 0x02 2 Byte, Länge der
KommunikationsparameterSafeData[1] 0x00

PDU 2 SafeData[0] T_WD Low Byte FSoE-Watchdog-Zeit in ms;
Wertebereich: 12 bis
65534 ms

SafeData[1] T_WD High Byte

PDU 3 SafeData[0] 0x06 6 Byte, Länge der
ApplikationsparameterSafeData[1] 0x00

PDU 4 SafeData[0] 0x01 Identifikationsnummer SY6;
Wert = 1 (fest eingestellt!)SafeData[1] 0x00

PDU 5 SafeData[0] 0x00

SafeData[1] 0x00

PDU 6 SafeData[0] T_SS1 Low Byte Verzögerungszeit in s;
Wertebereich: 0 bis 655,35 s;
Auflösung: 1 LSB = 10 ms

SafeData[1] T_SS1 High Byte

Tab. 8: Process Data Units im FSoE-Zustand Parameter
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10 Mehr zu FSoE, Sicherheitsfunktionen und SY6?
Dieses Kapitel fasst die wesentlichen Begriffe, Beziehungen und Maßnahmen rund um FSoE, die Sicherheitsfunktionen STO
und SS1 sowie das Sicherheitsmodul SY6 zusammen.

10.1 FSoE: Fail Safe over EtherCAT
Parallel zu dem Echtzeit-Ethernet-System EtherCAT existiert ein Safety-Protokoll namens Safety over EtherCAT (FSoE = Fail 
Safe over EtherCAT) für die Übertragung von sicherheitsrelevanten Nachrichten zwischen FSoE-Geräten in einem Netz. Das 
Protokoll ist TÜV-zertifiziert und in der Norm IEC 61784-3 international standardisiert. Das Design von FSoE beruht auf dem 
Black-Channel-Prinzip.

Sichere Kommunikation

In jedem FSoE-Zyklus sendet ein FSoE-Master sicherheitsbezogene Daten an einen FSoE-Slave und startet zeitgleich einen 
Watchdog-Timer. Der FSoE-Slave quittiert die erhaltenen Daten vor deren Rücksendung an den Master und startet 
ebenfalls eine Laufzeitüberwachung per Watchdog-Timer. Der Master empfängt und verarbeitet die Quittierung des Slaves 
und stoppt den Watchdog-Timer. Wurden die Daten vollständig verarbeitet, generiert der FSoE-Master ein neues 
Datenpaket.

Eindeutige FSoE-Adressierung

Jeder FSoE-Slave muss über eine eindeutige FSoE-Adresse identifizierbar sein.

Die Adresse wird über einen DIP-Schalter am Gerät selbst vergeben. Eine gültige Adresse liegt im Adressbereich 1 – 255 
(8 Bit, Adresse 0 darf nicht vergeben werden).

10.2 Sicherheitsfunktionen
Das Sicherheitsmodul SY6 unterstützt die Sicherheitsfunktionen Safe Torque Off (STO) und Safe Stop 1 (SS1-t). Die
Sicherheitssteuerung muss sowohl den STO- als auch den SS1-Ausgang des Antriebsreglers ansteuern, wenn die
Antriebsachse bewegt werden soll. Wird nur einer der Ausgänge konfiguriert, bleibt der Antriebsregler im sicheren Zustand
(STO aktiv).

Die Sicherheitsfunktionen sind gerätebezogen, nicht achsspezifisch. Das bedeutet, dass bei Mehrachsreglern nicht einzelne
Achsen, sondern ausschließlich der komplette Antriebsregler in den sicheren Zustand gesetzt werden kann.
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10.2.1 Safe Torque Off – STO

STO

Torque
on Motor

Speed

t

t

t

t

STO State

1

n

1

On

Abb. 8: Funktionsprinzip STO nach ETG.6100.2

STO entspricht Stoppkategorie 0 gemäß EN 60204.

Bei STO handelt es sich um die grundlegendste antriebsintegrierte Sicherheitsfunktion. STO verhindert, dass eine
drehmomentbildende Energie an einem angeschlossenen Motor wirken kann und ein ungewollter Anlauf verhindert wird.
Ziel ist, Personen- und Sachschäden durch einen sich drehenden und unabsichtlich in Betrieb gesetzten Motor sicher
auszuschließen.

Der Einsatz von STO ist immer dann geeignet, wenn der Motor durch das Lastmoment oder durch Reibung in ausreichend
kurzer Zeit selbst zum Stillstand kommt – oder in einer Umgebung, in der ein Austrudeln des Motors keine
sicherheitstechnische Relevanz darstellt.
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10.2.2 Safe Stop 1 – SS1-t

SS1

Speed

t

t

t

t

STO State

1

On

1

Torque
on Motor

t

1

SS1 State

T_SS1t0 t1

n

Abb. 9: Funktionsprinzip SS1-t nach ETG.6100.2

t0 Aktivierung SS1

t1 Aktivierung STO

T_SS1 SS1-Verzögerungszeit

SS1 entspricht Stoppkategorie 1 gemäß IEC 60204-1.

Im Fall von SS1-t erfolgt die Abschaltung nach einer konfigurierbaren Zeit.

Die Sicherheitsfunktion SS1-t ermöglicht das kontrollierte Stillsetzen eines Motors und schaltet diesen nach Ablauf der
parametrierten SS1-Verzögerungszeit drehmomentfrei, d. h., die Sicherheitsfunktion STO wird aktiviert. Das Auslösen von
STO erfolgt zeitverzögert, unabhängig davon, ob der Stillstand des Motors bereits erreicht ist.

Information

Beachten Sie, dass der Antriebsregler während der SS1-Verzögerungszeit weiterhin den Sollwerten der Steuerung folgt, was
ein kontrolliertes Stillsetzen bei Multiachs-Anwendungen ermöglicht.

Bei der SS1-Verzögerungszeit T_SS1 handelt es sich um einen sicherheitsrelevanten Parameter, der in der
Automatisierungs-Software parametriert und auf den FSoE-Master übertragen wird. Bei der Initialisierung des FSoE-
Protokolls wird der Wert dieses Parameters von der Sicherheitssteuerung an den Antriebsregler transferiert und in der
DriveControlSuite über Parameter S593 SS1 time to STO angezeigt.
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10.3 SY6: FSoE-Adresse vergeben
Um das Sicherheitsmodul eindeutig im FSoE-Netzwerk identifizieren zu können, müssen Sie diesem eine FSoE-Adresse aus
dem Adressbereich 1 – 255 manuell über einen DIP-Schalter zuweisen. Adresse 0 ist ungültig, d. h., bei der Vergabe der
Adresse 0 wird der Wert ignoriert und SY6 verbleibt im Zustand STO.

Information

Beachten Sie, dass der Antriebsregler ausgeschaltet sein muss, bevor Sie die FSoE-Adresse über den DIP-Schalter vergeben.
Die Adresse wird ausschließlich mit einem Neustart des Antriebsreglers übernommen.

FSoE-Adresseingabe über DIP-Schalter

Der DIP-Schalter für die Adresseingabe befindet sich auf der Oberseite des Antriebsreglers. Die Adresse ergibt sich aus den
Wertigkeiten der DIP-Schalter, die auf ON gesetzt sind. Nachfolgende Grafik zeigt das Sicherheitsmodul samt DIP-Schalter
mit den Wertigkeiten 2 und 8; die zugehörige FSoE-Adresse lautet 10.

Abb. 10: SY6 – DIP-Schalter

Schalternummer 1 2 3 4 5 6 7 8

Wertigkeit – FSoE-Adresse 1 2 4 8 16 32 64 128

Tab. 9: DIP-Schalter und FSoE-Adressen

FSoE-Adresse in SY6 überprüfen

Die von Ihnen vergebene FSoE-Adresse für das Sicherheitsmodul können Sie über Parameter S21 FSoE-Slave-Adresse der
DriveControlSuite verifizieren.
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10.4 Safety-Systemzeit

Systemzeit

Sensor Sicherer
Eingang

FSoE-
Master

EtherCAT-
Master

EtherCAT-
Master

Kommunikation Kommunikation

Reaktionszeit Reaktionszeit Reaktionszeit ReaktionszeitReaktionszeitReaktionszeit

Antriebsregler

Abb. 11: Reaktionszeiten und Safety-Systemzeit

Unter der STO-Systemzeit versteht man die Zeitspanne von der Anforderung der sicheren Abschaltung (STO) an einem
Sensor bis hin zum tatsächlichen sicheren Abschalten am EtherCAT-Anschluss des Antriebsreglers.

Die Systemzeit hängt von den Reaktionszeiten der einzelnen Systemkomponenten sowie von den Kommunikations- und
Übertragungszeiten im EtherCAT-Verbund ab.

Die zugehörigen Prozesse sind:

§ Sensor:
STO-Anforderungssignal zur Verfügung stellen

§ Safety-Terminal (sicherer Eingang):
STO-Anforderungssignal erkennen

§ EtherCAT-Master: 
Zustand des sicheren Eingangs an den FSoE-Master übertragen

§ FSoE-Master:
STO-Anforderungssignal auswerten

§ EtherCAT-Master: 
STO-Anforderungssignal an den Antriebsregler übertragen

§ Antriebsregler: 
STO aktivieren und abschalten (STO-Abschaltzeit); dieser Vorgang splittet sich in ....

• EtherCAT-Verarbeitungszeit im Steuerteil

• Transferzeit des Datenpakets zum Sicherheitsmodul SY6

• SY6: Dauer für die Auswertung des Datenpakets

• Abschaltzeit des Leistungsteils

10.5 FSoE-Watchdog-Zeit
Um mögliche Störungen zu erkennen, wird die Kommunikation zwischen FSoE-Master und -Slave durch einen FSoE-
Watchdog überwacht. Sobald ein FSoE-Telegramm versendet wurde, starten sowohl Master als auch Slave einen
sogenannten Watchdog. Erhalten Master oder Slave vor Ablauf der Watchdog-Zeit kein entsprechendes
Antworttelegramm, wechselt das jeweilige Gerät in einen sicheren Zustand. Die Watchdog-Zeit wird bei der Berechnung der
Worst-Case-Reaktionszeit berücksichtigt.

Die Watchdog-Zeit wird für jeden Slave individuell im FSoE-Master parametriert.

Bei TwinCAT 3 ist per Default eine globale Watchdog-Zeit von 100 ms eingestellt. Wenn Sie diese Default-Zeit ändern
möchten, wechseln Sie bei TwinCAT 3 in die Eigenschaften der jeweiligen Alias Devices einer TwinSAFE-Gruppe.
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11 Anhang

11.1 Unterstützte Kommunikationsobjekte

11.1.1 ETG.6100.3 Safety over EtherCAT Drive Profile: 6600 hex –
67FF hex

Nachfolgende Tabelle beinhaltet die unterstützen Kommunikationsobjekte des standarisierten Profils ETG.6100.3 Safety
over EtherCAT Drive Profile sowie deren Abbildung auf die entsprechenden STÖBER-spezifischen Parameter.

Index Subindex TxPDO RxPDO Name Kommentar

6600 hex 0 hex — — Time unit Einheit: 10 ms

6620 hex Safety controlword Array

6620 hex 0 hex — — Highest subindex supported Anzahl Array-Elemente: 2

6620 hex 1 hex — — Safety controlword, 
1st byte

S544[0]

6620 hex 2 hex — — Safety controlword, 
2nd byte

S544[1]; 
ohne Funktion

6621 hex Safety statusword Array

6621 hex 0 hex — — Highest subindex supported Anzahl Array-Elemente: 2

6621 hex 1 hex — — Safety statusword, 
1st byte

S545[0]

6621 hex 2 hex — — Safety statusword, 
2nd byte

S545[1]; ohne Funktion

6640 hex 0 hex — — STO command supported Funktion wird unterstützt = 1

6641 hex 0 hex — — STO restart acknowledge STO restart ohne
acknowledge = 0

6650 hex 0 hex — — SS1 command supported Funktion wird unterstützt = 1

6651 hex 0 hex — — SS1 time to STO S593, Einheit in Objekt 6600
hex definiert

Tab. 10: Kommunikationsobjekte ETG.6100.3: 6600 hex – 67FF hex
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11.1.2 ETG.5001.4 Safety over EtherCAT: E000 hex – EFFF hex
Nachfolgende Tabelle beinhaltet die unterstützen Kommunikationsobjekte des standarisierten Profils ETG.5001.4 Safety
over EtherCAT.

Index Subindex TxPDO RxPDO Name Kommentar

E901 hex FSoE Connection
Communication Parameter

Struktur

E901 hex 0 hex — — Highest subindex supported Anzahl Strukturelemente: 8

E901 hex 1 hex — — Version

E901 hex 2 hex — — FSoE slave address

E901 hex 3 hex — — Connection ID

E901 hex 4 hex — ✓ Watchdog time

E901 hex 5 hex — — Reserved

E901 hex 6 hex — — Connection type

E901 hex 7 hex — — ComParameterLength

E901 hex 8 hex — — ApplParameterLength

F980 hex 0 hex — — FSoE slave address

Tab. 11: Kommunikationsobjekte ETG.5001.4: E000 hex – EFFF hex
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11.2 Weiterführende Informationen
Die in nachfolgender Tabelle gelisteten Dokumentationen liefern weitere relevante Informationen zum Antriebsregler.

Aktuelle Dokumentversionen finden Sie unter http://www.stoeber.de/de/downloads/.

Gerät/Software Dokumentation Inhalte ID

Antriebsregler SC6 Handbuch Systemaufbau, technische Daten,
Projektierung, Lagerung, Einbau,
Anschluss, Inbetriebnahme,
Betrieb, Service, Diagnose

442789

Antriebsregler SC6 Inbetriebnahmeanleitung Systemaufbau, technische Daten,
Lagerung, Einbau, Anschluss,
Inbetriebnahme

442792

Anreihtechnik mit SI6 und PS6 Handbuch Systemaufbau, technische Daten,
Projektierung, Lagerung, Einbau,
Anschluss, Inbetriebnahme,
Betrieb, Service, Diagnose

442727

Anreihtechnik mit SI6 und PS6 Inbetriebnahmeanleitung Systemaufbau, technische Daten,
Lagerung, Einbau, Anschluss,
Inbetriebnahme

442730

Kommunikation EtherCAT – SC6,
SI6

Handbuch Einbau, elektrische Installation,
Datentransfer, Inbetriebnahme,
weiterführende Informationen

443024

Zusätzliche Informationen und Quellen, die als Grundlage für diese Dokumentation dienen oder aus denen zitiert wird:

Beckhoff Automation GmbH & Co. KG (Hrsg): EtherCAT System-Dokumentation. Version 5.1. Verl, 2016.

Eine Basisversion der Automatisierungs-Software TwinCAT 3 erhalten Sie kostenfrei unter 
https://www.beckhoff.de/default.asp?download/tc3-downloads.htm.

EtherCAT Technology Group (ETG), 2012. ETG.1300 : EtherCAT Indicator and Labeling. ETG.1300 S (R) V1.1.0. Specification.
27.01.2012.

EtherCAT Technology Group (ETG), 2016. ETG.5001: Modular Device Profile, Part 4: Safety Modules Specification.
ETG.5001.4 S (D) V0.2.1. Specification. 05.08.2016.

EtherCAT Technology Group (ETG), 2016. ETG.6100: Safety Drive Profile, Part 1: Overview, Scope. ETG.6100.1 S (R) V1.2.0.
Specification. 08.02.2016.

EtherCAT Technology Group (ETG), 2016. ETG.6100: Safety Drive Profile, Part 2: Generic Safety Drive Profile for adjustable
speed electrical power drive systems that are suitable for use in safety-related applications PDS(SR). ETG.6100.2 S (R) V1.2.0.
Specification. 08.02.2016.

EtherCAT Technology Group (ETG), 2016. ETG.6100: Safety Drive Profile Part 3: Mapping to Safety-over-EtherCAT.
ETG.6100.3 S (WD) V1.2.0. Specification. 08.02.2016.

http://www.stoeber.de/de/downloads/
https://www.beckhoff.de/default.asp?download/tc3-downloads.htm
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11.3 Abkürzungen

Abkürzung Bedeutung

µC Mikrocontroller

CRC Cyclic Redundancy Check (dt.: zyklische Redundanzprüfung)

EMV Elektromagnetische Verträglichkeit

ESI EtherCAT Slave Information (dt.: Gerätebeschreibung eines EtherCAT-Slaves)

ETG EtherCAT Technology Group

EtherCAT Ethernet for Control Automation Technology

FSoE Fail Safe over EtherCAT

IGBT Insulated Gate Bipolar Transistor (dt.: Bipolartransistor mit isolierter Gate-
Elektrode)

I/O Input/Output (dt.: Eingabe/Ausgabe)

PDO Process Data Objects (dt.: Prozessdaten-Objekte)

PDS(SR) Power Drive System(Safety Related) (dt.: Leistungsantriebssystem mit
integrierter Sicherheitsfunktion)

PDU Process Data Units (dt.: Prozessdaten-Einheiten)

PL Performance Level (dt.: Leistungsgrad)

PWM Pulsweitenmodulation

RxPDO Receive-PDO (dt.: Empfangs-Prozessdaten)

SIL Safety Integrity Level (dt.: Sicherheits-Integritätslevel)

SIL CL Safety Inegrity Level Claim Limit (dt.: Anspruchsgrenze des Integritätslevels
Sicherheit)

SPS Speicherprogrammierbare Steuerung

SRECS Safety Related Electrical Control System (dt.: sicherheitsbezogenes elektr.
Steuerungssystem einer Maschine)

SRP/CS Safety Related Part of a Control System (dt.: sicherheitsbezogenes Teil einer
Steuerung)

SS1 Safe Stop 1 (dt.: sicherer Stopp 1)

SS1-t Save Stop 1-time (dt.: sicherer Stopp 1, zeitgesteuert)

STO Safe Torque Off (dt.: sicher abgeschaltetes Moment)

TwinCAT The Windows Control and Automation Technology

TxPDO Transmit-PDO (dt.: Sende-Prozessdaten)
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12 Kontakt

12.1 Beratung, Service, Anschrift
Wir helfen Ihnen gerne weiter!

Auf unserer Webseite stellen wir Ihnen zahlreiche Informationen und Dienstleistungen rund um unsere Produkte bereit:
http://www.stoeber.de/de/service

Für darüber hinausgehende oder individuelle Informationen, kontaktieren Sie unseren Beratungs- und Support-Service:
http://www.stoeber.de/de/support

Sie benötigen unseren First Level Support:
Fon +49 7231 582-3060
applications@stoeber.de

Sie benötigen ein Ersatzgerät:
Fon +49 7231 582-1128
replace@stoeber.de

So erreichen Sie unsere 24 h Service-Hotline:
Fon +49 7231 582-3000

Unsere Anschrift lautet:
STÖBER Antriebstechnik GmbH + Co. KG
Kieselbronner Straße 12
75177 Pforzheim, Germany

12.2 Ihre Meinung ist uns wichtig
Diese Dokumentation erstellten wir nach bestem Wissen mit dem Ziel, Sie beim Auf-und Ausbau Ihres Know-hows rund um
unser Produkt nutzbringend und effizient zu unterstützen.

Ihre Anregungen, Meinungen, Wünsche und konstruktive Kritik helfen uns, die Qualität unserer Dokumentation
sicherzustellen und weiterzuentwickeln.
Wenn Sie uns aus genannten Gründen kontaktieren möchten, freuen wir uns über eine E-Mail an:
documentation@stoeber.de

Vielen Dank für Ihr Interesse.
Ihr STÖBER Redaktionsteam

http://www.stoeber.de/de/service
http://www.stoeber.de/de/support
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12.3 Weltweite Kundennähe
Wir beraten und unterstützen Sie mit Kompetenz und Leistungsbereitschaft in über 40 Ländern weltweit:

STOBER AUSTRIA
www.stoeber.at
Tel. +43 7613 7600-0
sales@stoeber.at

STOBER SOUTH EAST ASIA
www.stober.sg
sales@stober.sg

STOBER CHINA 
www.stoeber.cn 
Tel. +86 512 5320 8850
sales@stoeber.cn

STOBER SWITZERLAND 
www.stoeber.ch 
Tel. +41 56 496 96 50 
sales@stoeber.ch

STOBER FRANCE 
www.stober.fr 
Tel. +33 4 78.98.91.80 
sales@stober.fr

STOBER TAIWAN 
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Black-Channel-Prinzip

Technik, die die Übertragung sicherer Daten über unsichere Netzwerk- oder Busleitungen erlaubt. Safety-
Komponenten können sicherheitsrelevante Daten Hardware-unabhängig mittels eines sicheren Protokolls übertragen,
das den zugrundeliegenden Netzwerkkanal durchtunnelt. Mögliche Übertragungsfehler sind in den Normen IEC
61784-3 und IEC 61508 festgehalten.

Broadcast-Domain

Logischer Verbund von Netzwerkgeräten in einem lokalen Netzwerk, der alle Teilnehmer über Broadcast erreicht.

ESI-Datei

Gerätebeschreibungsdatei für EtherCAT-Slaves. Gemäß ETG.2000: XML-Datei, die sämtliche relevanten Daten eines
EtherCAT-Teilnehmers im EtherCAT-System enthält, wie beispielsweise die Identität des Herstellers, den Produkt-Code,
die Version oder die Produktionsnummer. Der EtherCAT-Master benötigt diese Datei für die Konfiguration des
EtherCAT-Systems.

Fail Safe over EtherCAT (FSoE)

Protokoll zur Übertragung von sicherheitsrelevanten Daten über EtherCAT, unter Verwendung eines FSoE-Masters und
einer unbestimmten Anzahl von FSoE-Slaves (d. h. Geräte, die eine Safety over EtherCAT-Schnittstelle besitzen). Das
Protokoll ermöglicht die Realisierung funktionaler Sicherheit über EtherCAT. FSoE sowie dessen Implementierung sind
TÜV-zertifiziert und entsprechen den SIL 3-Anforderungen gemäß IEC 61508.

FSoE-Adresse

Jeder FSoE-Slave besitzt eine Adresse, die ihn im FSoE-Netzwerk eindeutig identifiziert. Die Adresse wird in der Regel
am Gerät selbst eingestellt, beispielsweise über einen DIP-Schalter. In einem FSoE-System können maximal 65.534 
(16 Bit, Adresse 0 ist nicht erlaubt) Teilnehmer durch ihre Adressen voneinander unterschieden werden.

Gebrauchsdauer (TM)

Gemäß DIN EN 61800-5-2: Festgelegte kumulierte Betriebsdauer des PDS(SR) während seiner Gesamtlebensdauer.

Insulated Gate Bipolar Transistor (IGBT)

Bipolartransistor mit isolierter Gate-Elektrode. Vierschicht-Hableiterbauelement, das über ein Gate gesteuert wird und
die Vorteile von Bipolar- und Feldeffekttransistor vereinigt. Ein IGBT wird hauptsächlich in der Leistungselektronik
eingesetzt.

IPv4-Limited-Broadcast

Art eines Broadcast in einem Netzwerk mit IPv4 (Internet Protocol Version 4). Als Ziel wird die IP-Adresse
255.255.255.255 angegeben. Der Inhalt des Broadcast wird von einem Router nicht umgeleitet und ist somit auf das
eigene lokale Netzwerk limitiert.
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Kategorie

Gemäß DIN EN ISO 13849-1: Einstufung der sicherheitsbezogenen Teile einer Steuerung bezüglich ihres Widerstands
gegen Fehler und ihres nachfolgenden Verhaltens bei einem Fehler. Eine Kategorie wird erreicht durch die Struktur und
die Anordnung der Teile, deren Fehlererkennung und/oder ihre Zuverlässigkeit. Mögliche Kategoriebezeichnungen, 
d. h. Einstufungen sind B, 1, 2, 3, 4.

PDO

Kommunikationsobjekte in einem CANopen- oder EtherCAT-Netzwerk, die Daten wie Soll- und Istwerte, Steuerbefehle
oder Statusinformationen ereignis- oder zielorientiert, zyklisch oder auf Anforderung in Echtzeit übertragen. PDO
werden über den Prozessdaten-Kanal generell mit hoher Priorität ausgetauscht. Abhängig von der Sicht der jeweiligen
Teilnehmer werden Empfangs-PDO (RxPDO) von Sende-PDO (TxPDO) unterschieden.

Performance Level (PL)

Gemäß DIN EN 13849-1: Maß für die Zuverlässigkeit einer Sicherheitsfunktion oder eines Bauteils. Der Performance
Level wird auf einer Skala von a – e (geringster – höchster PL) bemessen. Je höher der PL, desto sicherer und
zuverlässiger ist die betrachtete Funktion. Der PL kann einem bestimmten SIL zugeordnet werden. Ein umgekehrter
Rückschluss von einem SIL zu einem PL ist nicht möglich.

Probabilitiy of a dangerous Failure per Hour (PFHD)

Gemäß DIN EN 61508/DIN EN 62061: Durchschnittliche Wahrscheinlichkeit eines gefährlichen Geräteausfalls pro
Stunde. Zusammen mit PFH eine der wesentlichen Berechnungsgrundlagen für die Zuverlässigkeit der
Sicherheitsfunktion von Geräten, dem SIL.

Safe Stop 1 (SS1)

Gemäß DIN EN 61800-5-2: Verfahren zum Stillsetzen eines PDS(SR). Bei der Sicherheitsfunktion SS1 führt das PDS(SR)
eine der folgenden Funktionen aus: 
a) Auslösen und Steuern der Größe der Motorverzögerung innerhalb festgelegter Grenzen und Auslösen der STO-
Funktion, wenn die Motordrehzahl unter einen festgelegten Grenzwert fällt (SS1-d), oder
b) Auslösen und Überwachen der Größe der Motorverzögerung innerhalb festgelegter Grenzen und Auslösen der STO-
Funktion, wenn die Motordrehzahl unter einen festgelegten Grenzwert fällt (SS1-r), oder
c) Auslösen der Motorverzögerung und Auslösen der STO-Funktion nach einer anwendungsspezifischen
Zeitverzögerung (SS1-t). SS1(-t) entspricht in diesem Fall dem zeitgesteuerten Stillsetzen nach IEC 60204-1,
Stoppkategorie 1(-t).

Safe Torque Off (STO)

Gemäß DIN EN 61800-5-2: Verfahren zum Stillsetzen eines PDS(SR). Bei der Sicherheitsfunktion STO wird dem Motor
keine Energie zugeführt, die eine Drehung (oder bei einem Linearmotor eine Bewegung) verursachen kann. Das
PDS(SR) liefert keine Energie an den Motor, die eine Drehmoment (oder bei einem Linearmotor eine Kraft) erzeugen
kann. STO ist die grundlegendste antriebsintegrierte Sicherheitsfunktion. Sie entspricht dem ungesteuerten Stillsetzen
nach DIN EN 60204-1, Stoppkategorie 0.

Safety Integrity Level (SIL)

Gemäß DIN EN 61800-5-2: Ausfallwahrscheinlichkeit einer Sicherheitsfunktion. SIL ist in die Stufen 1 – 4 (geringster –
höchster Level) eingeteilt. Durch SIL werden Systeme oder Teilsysteme auf ihre Zuverlässigkeit von
Sicherheitsfunktionen exakt beurteilt. Je höher der SIL, desto sicherer und zuverlässiger ist die betrachtete Funktion.
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Safety Integrity Level Claim Limit (SIL CL)

Maximaler SIL, der beansprucht werden kann – bezogen auf strukturelle Einschränkungen und systematische
Sicherheitsintegrität eines SRECS-Teilsystems. Ein SIL CL wird durch die Hardware-Fehlertoleranz (HFT) und den Anteil
sicherer Ausfälle der Teilsysteme (SFF) bestimmt.

STO-Abschaltzeit

Zeitspanne ab dem Aktivieren der Sicherheitsfunktion bis hin zum sicheren Abschalten des Leistungsteils des
Antriebsreglers.

Worst-Case-Reaktionszeit

Maximale Zeitspanne, die benötigt wird, um den Aktor im Fehlerfall abzuschalten.
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